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Abstract

Cities play a central role in addressing current and future social 
and ecological challenges. Meeting these challenges requires 
us to take a comprehensive approach to the planning and de-
veloping our urban environments. A challenge in the Swedish 
planning system is the gap between strategic planning and 
detailed planning. This gap could hinder positive system e昀昀ects 
and limit the potential of planning. Furthermore, if con昀氀icts 
between social and ecological aspects are not identi昀椀ed and 
addressed early in the planning process, resolving them later 
becomes both more di昀케cult and expensive. 
 
This thesis explores how an evidence-based design method can 
bridge this gap. The aim is to develop a framework for plan-
ning places based on their system conditions, with the goal 
of achieving desirable system e昀昀ects. The design method also 
aims to foster a deeper understanding of the system by provid-
ing spatial insight into potential con昀氀icts between social and 
ecological values in urban development projects and o昀昀ering 
strategies for managing these con昀氀icts through urban design 
and planning. 
 
The method is being applied and tested on a site in the mu-
nicipality of Varberg, which has been selected as a case study. 
Several spatial studies are being conducted on the site to an-
alyse its spatial con昀椀guration and identify how it may con-
tribute to socio-ecological con昀氀icts, as well as which con昀氀icts 
may potentially arise in future development. Furthermore, the 
evidence-based design method is used to investigate the pos-
sibilities for mitigating these con昀氀icts while enhancing desired 
system e昀昀ects.
 
The design phase involves testing and evaluating di昀昀erent spa-
tial con昀椀gurations, based on the thesis’s theoretical framework. 
Based on these evaluations, the site’s spatial con昀椀guration is 
redesigned to achieve the desired e昀昀ects. This iterative design 
process contributes to knowledge development by demonstrat-
ing the impact of di昀昀erent con昀椀gurations on socio-ecological 
conditions.

The study results in an evidence-based design process that 
can be incorporated into the planning of urban development 
projects, helping to identify contextual design criteria that can 
enhance positive system e昀昀ects and mitigate potential con昀氀icts 
between ecological and social aspects.
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Background

Cities are hubs of economic activity, cultural exchange and social 
cohesion, but they can also be centres of environmental degradation 
and social inequality. The planning and development of our cities, 
often driven by economic growth and expansion, has largely failed to 
address the broader ecological and social consequences of urbanisa-
tion, resulting in unsustainable resource consumption and deepening 
socio-economic divides (UN Habitat, 2024; UN, n.d). For example, the 
green space in Sweden’s 20 largest cities decreased by approximate-
ly 1.1 million square meters (equivalent to approximately 153 soccer 
fields) between 2021 and 2022 (HUGSI 2024). Moreover, the IPCC 
(2022) estimates that 70 % of global carbon emissions originate from 
urban areas, with transport and buildings being the largest contribu-
tors. 

While cities are at the centre of many social and climate-related chal-
lenges, they also have the potential to be at the forefront of address-
ing these challenges directly. As highlighted in the UN Habitat World 
Cities Report (2024), urban areas are crucial in the global effort to 
tackle climate change and social inequality. It is therefore important 
that urban planning is characterised by a more holistic approach that 
considers the multidisciplinary and complex challenges we face. 

Kate Raworth (2017) who’s the founder of Doughnut economics, a 
theory about how we can make a transition to live within planetary 
boundaries, argues that one pillar of enabling this is by making a 
shift to systems thinking in how we plan our cities. Systems thinking 
is a holistic method of analysis that focuses on how different parts 
of a system interact and how they affect each other within a whole 
(Colding et al, 2022). Cities are made up of multiple systems that are 
constantly evolving and influenced by each other. For example, the 
design of the street network and the density of buildings affect how 
and where people move in- and around the city. Furthermore, a higher 
flow of people generates a greater basis for economic activities and 
opportunities for people to meet. This shows how the street network 
and urban density as a system interact to influence social and eco-
nomic systems in the city. It is therefore important to recognise that 
the processes that take place at the local level are often dependent on 
system characteristics at larger levels.

However, system effects are not always positive and may also conflict 
with each other. For example, higher building and population den-
sities can be positive from certain economic (larger customer base) 
and ecological (less resource use) perspectives (Colding et al, 2022). 
At the same time, it can have negative consequences in the form of 
more congestion in the city, leading to increased stress among the 
population and the exploitation of green spaces that are important for 
people’s well-being and ecological functions in the city.  It is there-
fore important that these potential conflicts are addressed in the early 
planning process as they can be both more difficult to manage at a 
later stage.

The planning of our cities is thus a central part of how we will meet 
and cope with our future challenges. In Sweden, planning is governed 
by Plan- och bygglagen (PBL) and municipalities have a planning 
monopoly, meaning that they alone have the power to decide how land 
and water resources in their municipality are to be planned and uti-
lised (Boverket, 2023). Municipalities have two main planning tools, 
the comprehensive plan and the detailed plan, which are regulated by 
the PBL. The comprehensive plan is linked to the strategic planning of 
the city and the detailed plan is a legally binding document that regu-
lates the land use of places. According to PBL, every municipality must 

Figure 1: The doughnut model

Figure 2: Different systems interact 
and affect each other across differ-
ent scales

01. Introduction
This chapter presents the overall 
subject area in which the study oper-
ates, as well as the problem formula-
tion and the two underlying research 
questions on which the thesis will be 
based on.
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Delimitations

The aim of this thesis is to investigate how a design methodology 
can serve as a tool to bridge the gap between strategic planning and 
detailed planning in urban development projects. The study focuses 
on how this process can be used to formulate design criteria that both 
mitigate potential conflicts between social and ecological aspects and 
that can enhance their positive systemic effects in the built environ-
ment. Therefore, the following research question has been chosen as 
the basis for the study:

How can a design methodology be used to identify context specific 
design criteria based on a site’s systemic conditions, in order to 
support the planning process in medium-sized Swedish cities?

How can a design methodology help identify design criteria that 
mitigate social-ecological conflicts, and thereby contribute to more 

informed planning processes in medium-sized Swedish cities?

The study is based on the functional dimension of the city, which 
means that the focus is on the physical and economic structures that 
influence how people and animals use the built environment (Marcus 
2022, p. 23). The delimitation consists in analysing only the morpho-
logical elements of the city and the system effects they give impact to,  
paying particular attention to system aspects such as density, con-
nectivity, co-presence, habitat connectivity and land use. . In terms of 
Space syntax, the main focus will lie on the betweenness centrality, as 
the street network in Varberg is well integrated, the integration cen-
trality is not as relevant.

Social justice and inclusion issues, including socio-economic aspects, 
fall outside the scope of the study. Even if aspects such as accessibility 
to parks and green spaces are related to the questions, they won’t be 
the focus of this thesis.

Habitat connectivity is examined exclusively in terms of land use, 
dispersal routes, barriers and value centres for bees. Other factors that 
may affect bee’s habitats and dispersal, such as noise, are not includ-
ed, although they may be relevant to the study question. However, 
these are beyond the scope and time frame of the work. 

Aim & research questions
have a valid and relevant comprehensive plan that sets out the mu-
nicipality’s long term planning for the management of land and water 
resources. The plan therefore addresses the overall structure of the 
city and many of the system characteristics that influence the condi-
tions for the processes that take place at the local level. In the case of 
particularly important areas, an in-depth comprehensive plan (FÖP) 
can be produced, which can deal with a greater degree of detail of the 
issues than covered by the comprehensive plan (SOU 2018:46). What is 
written in the comprehensive plan is not legally binding, but is strictly 
advisory when, for example, new detailed plans are drawn up.

In addition to this, there are also several other guiding municipal 
planning documents, such as planning programmes or structure 
plans, but these are not legally binding or regulated in PBL. Bover-
ket (2022a), The National Board of Housing, Building and Planning, 
recommends that these shall be produced to guide future detailed 
planning work and that they can be beneficial when many stakehold-
ers with different opinions are affected by the planning. As they are 
not regulated, there is no given process or content requirements, it is 
instead up to the municipalities themselves to design them.

A challenge in the Swedish planning system is the gap between the 
strategic planning and detailed planning (SOU2018:46). In its eval-
uation of comprehensive planning, Boverket assesses that there is a 
need for municipalities to investigate issues at a more comprehensive 
level than the detailed plan allows, but within a more limited area 
and with a higher degree of detail than the comprehensive plan. The 
programmes that the municipalities themselves choose to produce, 
such as planning programmes or structure plans, are intended to 
meet these needs. However, Boverkets evaluation shows that there is 
considerable uncertainty as to what these programmes should contain 
and how they can be produced and used. This risk leading to a situa-
tion where how the built environment and green spaces in the city are 
planned and developed is not adapted to their systemic conditions and 
the city’s overall structures.

Problem

Figure 3: Relation between influence 
and cost during a process

Influence over outcomes

Start Time

Cost
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02. Methodology
Methodology is the theoretical framework 
that guides how the research is conducted, 
while methods are the specific tools or tech-
niques used during the process.

Affordance: Refers to the possibilities for action that an environment or object 
offers an individual, depending on both the characteristics of the object and the 
abilities of the individual.

Co-presence: The potential to meet people from various parts of the city in one 
place.

Detailed plan: A legally binding document that regulates the land use of places.

Evidence-based design: A design approach where design decisions are based 
on scientific evidence.

Functional form: The functional form of built-up land is interlinked with its affor-
dances, meaning it is about the possibilities it gives its users and how it enables 
different uses.

Habitat connectivity: How well different habitats for a specific species is con-
nected.

Core value habitats: areas or places with particularly high ecological values 
and are a central part of several ecosystems. Often reproduction sites for species.

Dispersal zones: The distance a certain species can travel from its reproduction 
site.

Dispersal corridors: Green corridors that connect core value habitats.

Local scale: How both humans and animals perceive and interact with the urban 
environment.

Social-ecological urbanism: An approach that examines how processes at a 
global scale affect social and ecological processes at a local scale.

Space syntax: A spatial analysis that examines the street network through the 
variables of integration and betweenness centrality.

•	 Integration: A measure of how well a street segment is integrated into the 
street network

•	 Betweenness: A measure of how often a street segment is used if you walk 
from each segment to all other segments.

Strategic planning: The municipality’s long-term planning for the management of 
land and water resources.

System scale: Processes and spatial configurations at a global (city) scale, such 
as street network centrality, density, and habitat connectivity.

Terminology
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Methodology

Bill Hillier (1996, p. 2), one of the founders of space syntax and the 
theory of natural movement, argues that many of the architectural 
theories that emerged during the 20th century have two main weak-
nesses: they have been overly normative and insufficiently analytical. 
A normative theory is a type of theory that deals with how something 
should be, rather than how it actually is. It expresses values, ideals, 
or goals, often with the aim of influencing future decisions or actions. 
In architecture, this means that a normative theory prescribes which 
forms, structures, or urban planning principles are considered good or 
right, without necessarily examining why they work, when they work, 
or whether they work in practice.

To overcome this, Hillier (1996, pp. 27-29) calls for more analytical 
architectural theories that deepen our understanding of architec-
ture as a phenomenon. Hillier argues that architectural theory can 
be understood as an attempt to put into words things in architecture 
that we otherwise find difficult to talk about, such as spatial patterns, 
forms, and relationships that are not easily described. By translating 
these into concepts, language, and numbers, we can understand and 
work with them in a more systematic way. In this way, theories help 
us understand the underlying spatial principles of architecture, rather 
than simply judging whether something is “right” or “wrong.”

Evidence based design
In line with this, the methodology is based on an evidence-based 
design process, where the methods of Space- and Places syntax, Space 
matrix, and habitat network connectivity  have been chosen as an 
analytical framework. These methods provide objective descriptions of 
system relationships in the built environment, enabling us to under-
stand the underlying spatial logic of different environments without 
imposing a normative description of them.

Further, the EBD methodology will be divided into two steps, as sug-
gested by Karimi (2023, p. 1). In the first stage, a series of analyses 
are carried out at both local and global levels, examining the spatial 
networks. These analyses reveal various structural patterns in the city 
that govern human activity and urban functions, which also creates a 
contextual understanding. This understanding is an important part of 
identifying challenges and opportunities within the area or city. It also 
has the potential to create improved or more contextually relevant 
design concepts and solutions.

The second step in the EBD methodology involves creating analytical 
models of different design proposals at an early stage of the process. 
These models serve as tools for reviewing and evaluating design ideas 
and alternative solutions. This approach not only enables the integra-
tion of the city’s morphological structure into the design work but also 
deepens the iterative process of testing and evaluation that is central 
to design. It is particularly important that this evaluation is carried 
out in an objective and quantitative manner, which steers the design 
process towards a more analytical and evidence-based approach.

Research by design
To support the design and outline of the EBD methodology in the 
study, it’s further complemented by a “Research by design” frame-
work. Research by design is about how to generate new knowledge 
through creative and practical processes. Johan Verbeke (1991) de-
scribes in the book ‘Design research in architecture’ that a key in this 
type of research is the reflection and review of the creative process to 

Evidence based design (EBD)
Evidence-based design means that the impact of the built environ-
ment on humans and animals is analysed based on measurable stud-
ies and research results (Boverket, 2022b). Within EBD, evidence is 
not regarded as absolute truth, but rather as gradual levels of sci-
entific support. Only the highest levels of evidence, such as results 
from large, well-controlled and replicable studies, are considered 
to demonstrate cause and effect (Berghauser Pont, 2024). Studying 
complex urban landscapes requires both theoretical tools and meth-
odological approaches that enable a deeper understanding of how the 
physical forms, structures, and functions of cities interact with human 
behaviours and usage patterns (Kamiri 2023, pp. 20-21). EBD is rooted 
in an interdisciplinary approach and can include sciences such as en-
vironmental psychology, ecology and architecture (Boverket, 2022b). 
EBD aims to ensure that actions and decisions in a design process are 
based on evidence from research or proven experience and local and 
contextual knowledge. EBD emphasises the importance of gathering 
knowledge and facts about the areas and contexts of projects. Both 
qualitative and quantitative knowledge is important. In many cases, 
different knowledge bases can conflict with each other, which is why it 
is important to account for and openly discuss the choices made in the 
design process so that they can be followed up and analysed. 

Social-ecological urbanism
Social-ecological urbanism is a theoretical approach to the relation-
ship between social and ecological systems and values in the city 
(Colding et al, 2022). The built environment and nature are not seen as 
two dichotomies, but as closely intertwined and mutually influential. 
The approach is based on using a systems approach and spatial anal-
ysis to understand how micro-level processes in the city are linked to 
overarching systems and structures. An example of this could be a city 
designed to encourage walking and cycling, which has positive health 
benefits and also allows road users to interact with their surroundings. 
This may promote social cohesion or better conditions for economic 
trade. In contrast, areas where interaction with the local environment 
is limited, for example by barriers such as roads and topography, can 
lead to segregation and exclusion.

Affordance
The theory of affordance has its origins in psychologist James J. 
Gibson’s research on visual perception and people’s interaction with 
their surroundings (Marcus 2022, pp. 22-25). According to Gibson, 
affordance refers to the possibilities for action that an environment 
or object offers an individual, depending on both the characteristics 
of the object and the abilities of the individual. It is therefore not just 
about what something is, but what it invites you to do. For example, 
a chair invites you to sit, a path invites you to walk, and a playground 
invites you to play, provided you can perceive and act on these possi-
bilities. This theoretical approach also relates to what Marcus calls the 
functional form off the city.

Affordance and the functional form of the city is linked to how we per-
ceive the environment around us through visual impressions (Marcus 
2022, pp. 22-25). This perception often leads directly to action, we act 
according to the possibilities created by our surroundings. In an urban 
context, this means that the physical form and design of the city in-
fluence how people move, spend time, and interact. Buildings, streets, 
squares, and green spaces offer different types of affordances that 
shape our behaviour and our experiences of the place.

Theoretical approach

EBD is based on three different types of 
knowledge bases: 

•	 Evidence - research and scientific basis
•	 Practice and proven experience
•	 Context - what is given in the specific 

situation, the local conditions.
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Process

By using these two theoretical frameworks it enables an iterative 
design process where different spatial configurations are tested and 
evaluated using analytical methods, and where the results of these are 
compared with important aspects that emerge in the studies theory 
chapter in accordance with EBD. The iterative design process itself 
contributes to knowledge production in the study by investigating 
how different configurations relate to different outcomes with differ-
ent system effects. The process in this study is divided in the following 
steps: 

1.	 A relevant knowledge base is collected based on the research ques-
tion of the paper. 

2.	  The city of Varberg is analysed through spatial analyses and 
theoretical frameworks to create an understanding of the current 
context and to highlight different system conditions  

3.	  The results are then weighed against Varberg’s municipal plan-
ning strategies to identify different suitable sites for development.  

4.	 A site is then chosen and analysed by different spatial analysis. 
Risks and potentials are identified for the site based on its system 
conditions and morphological attributes. 

5.	 A vision is formulated for how the site could be developed to gen-
erate positive system effects and to mitigate conflicts between 
social and ecological aspects.  

6.	  Different spatial strategies based on the theoretical part of the 
thesis ‘System effects’ are developed for how the system condi-
tions of the sites can be configured to enable the opportunities 
identified in the site analysis.  

7.	 The configurations are tested through spatial analyses to enable 
an evaluation between different configurations to compare their 
outcomes. 

8.	 Based on the chosen strategies, different design criteria are then 
selected based on the theoretical part ‘Local”. The purpose of the 
design criteria is to design the site in a way that both mitigates 
the conflict between different systems and can enhance positive 
system effects.  

9.	  A final design proposal is produced for each site showing how the 
design criteria can be implemented.

provide new knowledge and insights. Therefore, it is important that 
this process is clearly communicated so that it can be understood and 
valued by others. Furthermore, Verbeke provides examples of meth-
ods and criteria for knowledge production in design-based research, 
presenting a design scheme to support the structuring of research. The 
scheme contains four following phases:  

Input: In this phase, information and knowledge on which the re-
search is based is collected: this can be through, for example, litera-
ture studies, experiences, interviews or design projects that relate to 
the focus area.

Operations: In this phase, the material collected in the input phase 
is processed to create new insights by, for example, conducting new 
interviews or experiments or combining the material in new ways. 

Output/Knowledge: In this phase, the material from the operations 
phase is evaluated against the data in the input phase to create a result 
of the study. 

Delivery: In this phase, a concrete manifestation of the result of the 
Output phase is made through, for example, designs, design tools, 
articles or exhibitions.  

Verbeke emphasises that design, and practice should be a key compo-
nent throughout the project to create new understanding and knowl-
edge, calling this the ‘in the medium’ of architecture. This is because it 
allows knowledge to be produced from and through the design actions.

Discussion
Hillier (1996, pp. 59-61) argues that a problem with architectur-
al theories that are more normative than analytical is that they only 
work for certain types of architecture. For example, a theory based 
on geometric proportions cannot explain buildings that do not follow 
these proportions. Similarly, this means that these theories are limit-
ed and cannot be used as general tools for understanding or analysing 
all types of architecture. 

This study aims to combine theories about how different system 
configurations in the city create different system conditions for places 
within the city, with theories about how the functional form of cit-
ies can be used to reinforce positive and mitigate negative systemic 
effects. By integrating these perspectives, the study aims to develop a 
design methodology that not only explains how and why the built en-
vironment works the way it does but also identifies more precise and 
contextual design criteria.

The methodology functions as an analytical tool that can be applied in 
different urban contexts to identify spatial networks and system as-
pects within the city. These elements influence human activity, biodi-
versity, and urban functions, and their analysis contributes to building 
a contextual understanding of the city.

Based on this understanding, the methodology helps define normative 
design criteria that respond to both the identified system characteris-
tics and the local context. These criteria aim to guide the development 
of the built environment toward more desirable outcomes in terms of 
its functional form, ecological performance, and social dynamics.
While the design criteria are grounded in the specific context from 
which they are drawn, they can also be adapted and applied in other 
urban settings that share similar system conditions, increasing the 
generalization of the findings.

The four steps of Verbeks (1991) sug-
gested design scheme

Input

Operations

Output / Knowledge

Delivery
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Literature Studies
The aim is to provide a deeper understanding of theoretical concepts 
in urban morphology and their relationship to social and ecological 
systems within the built environment. This knowledge is essential 
for the Evidence-Based Design (EBD) approach to be meaningful, as 
it requires a comprehensive understanding of both the morphologi-
cal characteristics of urban form and the social contexts shaped by it 
(Karimi 2023, pp. 22-23). The focus extends the analysis of physical 
elements such as streets, blocks, and buildings, to include the ways 
in which these structures interact with social, economic, and cultural 
dynamics.

These insights will form the analytical foundation for developing de-
sign criteria at both the system scale and the local scale. By grounding 
design decisions in this multi-scaler analysis, the study aims to more 
accurately anticipate the implications of urban form and enhance the 
functionality of the proposed design interventions.

Space- and Place syntax
A range of spatial analyses will be conducted using GIS to investigate 
how different spatial configurations influence human behaviour, 
social interaction, and habitat connectivity. This approach is essential 
for moving from a descriptive analysis toward a more quantitative 
framework capable of predicting, evaluating, and assessing the effects 
of different spatial configurations (Karimi, 2023, p. 1). It also supports 
the integration of evidence-based design by incorporating predictive 
modelling into design processes.

The primary analytical tools employed will be Place Syntax and the 
Habitat Network Analysis Tool, which together will support a nuanced 
understanding of how spatial form shapes both ecological and social 
dynamics. Place Syntax is a QGIS plug-in that combines space syntax 
analysis of the road network with other tools such as attraction and 
accessibility analysis (Stavroulaki et al, 2023). The space syntax anal-
ysis is a critical part of the tool, and it shows the relative position of 
each road segment in the road network. This allows it to produce two 
different measurements: Angular Integration (AI) and Angular Be-
tweenness (AB). Angular integration shows how well the road segment 
is connected to all other road segments in the network, and angular 
betweenness shows how often a segment is used when you go from 
each segment to all other segments.

Space matrix
The model provides a holistic picture of building density where it 
combines the Floor Space Index (FSI) with the Ground Space Index 
(GSI). 

The Habitat Network Analysis
The Habitat Network Analysis (Hnat) tool uses a biotope map as the 
basis for a multi-species analysis to show where species’ reproduc-
tive habitats are located (functional map) and how well these habitats 
are connected (dispersal map) (Berghauser Pont et al, 2022). In this 
study the functionality and dispersal qualities for the species solitary 
tree living bee’s and the assessment of the habitats will be based on 
the parameters available through Chalmers Spatial Morphology Group 
(n.d).

Methods Space syntax

Habitat network analysis

Place syntax

Space matrix

Floor Space Index (FSI) 
The total floor area of the building in 
relation to the plot area. Measures the 
volume of the building in relation to land 
use.
Ground Space Index (GSI) 
The footprint of the building in relation to 
the plot area. Shows how much land is 
occupied by buildings.
Open Space Ratio (OSR)
Proportion of unoccupied land on the 
plot. Calculated as: OSR = 1 - GSI
Determines the availability of green 
spaces, courtyards, etc.
Layers (L)
Average number of floors
Provides an indication of the height of 
the building
Ax
Area of aggregation (District, fabric, 
block, parcel)
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Urban morphology
Urban morphology is the study of the physical structure of cities and 
how it changes over time (Carmona 2021, p. 196). The form of a city 
refers to the main physical elements that give the city its structure and 
shape. These elements can be divided into five categories:

•	 Districts
•	 Street networks
•	 Neighbourhoods
•	 Properties
•	 Buildings

These elements influence each other: the street network determines 
the size of the blocks, which in turn shapes the division of properties 
and the density of development. This interaction then determines how 
buildings are located and designed.

Lars Marcus (2020, pp. 86-90) distinguishes between the city’s func-
tional and representative form in his study of urban morphology. The 
functional form is about how the built city provides its users with uses 
and opportunities and whether the physical elements fulfil their prac-
tical purpose. Marcus (2022, pp. 23, 96) describes how the physical 
environment has a function as an “enabler” for human actions and, 
in doing so, highlights the relationship between the environment and 
humans. Cities and buildings are not built for their own sake, but to 
enable different land uses, which in turn affects how we use the city. 
Marcus relates this to the term “affordance” which means what pos-
sibilities and functions the built environment gives its users. The built 
environment and its spatial layout govern both where and how we 
move, where we choose to sit, and where we meet other people. The 
city’s representative form is instead about the aesthetic and symbolic 
design of the city.

This distinction is illustrated by Marcus (2020, pp. 86-90) comparing 
the neighbourhoods of Skarpnäck in Stockholm and Baronbackarna in 
Örebro. Skarpnäck was built as a traditional neighbourhood with the 
ambition of creating life and mixed functions, while Baronbackarna 
follows modernist ideals with functional separation and open devel-
opment. Paradoxically, both areas exhibit similarly low levels of urban 
life. Marcus (2022, p. 97) explains this by saying that, despite their 
different representative forms, both areas share the same structures 
in their functional form:

•	 Large-scale property structures with few housing associations, 
leading to less diversified land use. 

•	 Building entrances from inner courtyards, which shield the build-
ings from the street scape. 

•	 Isolated road networks that are not integrated with surrounding 
neighbourhoods. This structure breaks with classic urban planning 
traditions, where interconnected street networks create natural 
flows between neighbourhoods, which is a prerequisite for creat-
ing vibrant urban environments.

The street network
There are several different structures for organizing street networks, 
for example, through a block structure or a more organically devel-
oped structure. The design of the street network greatly influences 
how individual street segments relate to each other within the city’s 

System scale

Figure 5: Morphological elements
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Plots

Blocks / fabric

Street network
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03. Theory
The theory chapter is structured in two parts: “System Scale” and “Local 
Scale.” The first part, System Scale, focuses on the broader urban systems 
examined in the study, such as spatial networks, density, and green infrastruc-
ture. These components are analysed to understand how they shape the struc-
tural and functional conditions of the city.

The second part, Local Scale, explores how both humans and animals 
perceive and interact with the urban environment. It considers how the built 
environment can be designed to align with these system conditions and how 
design interventions can be used to strengthen positive system effects at the 
local level.
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Density, Mixed-use

Centrality Urban life
MovementConfiguration

the street network can be used to predict people’s movements in ur-
ban environments (Hillier, 2015). This can be achieved through a space 
syntax analysis which can measure what is known as angular integra-
tion and betweenness integration. Both these are topological measures 
that describes the relative position of a street system segment by ana-
lysing angle changes between it and other segments in the network. 
It is therefore not a geographical measure based on actual distances, 
but rather a way of counting the number of typological steps based on 
changes in direction. In this way, it is possible to analyse how many 
such steps are required to reach a given segment from all others in the 
system. Research shows that the amount of the movement in the city 
the analysis can explain varies in different cases, but the mean value 
is that it can explain 65% of the movement in a city (Stavroulaki et al 
2019, p. 16). 

Angular integration examines the relationship between each street 
segment and all other street segments, where a street segment that 
is more integrated with all other street segments is given a higher 
value. Betweenness integration assesses how often a street segment is 
passed when moving from one street segment to all others in the city. 
However, angular integration and betweenness can be distinguished 
by considering that the former measures “to movement”, which is 
how accessible the street segment is from all other street segments. 
Betweenness, on the other hand, shows the potential for “through 
movement”, which is the flows through the city. The analysis can be 
done on different scales, often two and five kilometres, to understand 
the street network locally and globally (the entire city). The purpose of 
the analysis is to evaluate the degree of integration between different 
neighbourhoods in the city, as well as how residents are integrated 
with the rest of the urban environment. 

In terms of space syntax, the concept of multiplier effect is also rele-
vant (Hillier 1993, p. 113). This means that streets with high centrality 
create greater flows. These flows make it more attractive for various 
businesses, functions, and activities to locate themselves near the 
flows, which then attracts an even greater flow.
At the same time, the centrality of a street segment can be controlled. 
For example, by breaking up the segment, it can be given a lower 
centrality, which may be desirable for a recreational area where more 
seclusion and privacy are sought. In contrast, the centrality of a street 
segment can be increased by integrating it more with the rest of the 
network and reducing the number of typological steps needed to reach 
it, which may be desirable for streets where a higher flow of people is 
desired.

An important aspect that can be measured using space syntax analysis 
is the potential for creating co-presence. Ann Legeby (2013, pp. 337-
338) defines co-presence as “the presence of different people in the 
same public space, creating potential for social interaction and com-
munity”. If the same street segment has a high betweenness centrality 
value at both the local and global levels, there is potential for the peo-
ple moving there to come from different parts of the city, both locally 
and globally. This means that there is potential to meet people from 
all over the city in the same place. At the same time, large areas with 
low closeness centrality can become socially isolated, as they are not 
integrated with the rest of the city and therefore people from other 
parts of the city do not go there.

Density
Density is a central but vague concept that can be defined and meas-
ured in different ways but has a major impact on the function and 

Figure 8: Multiplier effect

spatial system. One way to analyse these relationships is through a so-
called J-graph (Hillier 1996, p. 72). In a J-graph, each street segment 
is represented as a point (node), and a line is drawn between points 
that are directly connected to each other in physical space. This graph 
serves as an analytical tool for understanding a segment’s relative 
position in the entire street network. Segments that are weakly con-
nected to the rest of the network end up far out in the graph with few 
connections, while segments that are centrally located and strongly 
integrated with others appear as nodes with many connections.

Lars Marcus (2022, p. 47) distinguishes between two types of spatial 
systems of the street network: tree structures and network structures. 

•	 In a tree structure, there is often a main line from which branches 
lead out to different clusters. This type of structure is associated 
with the functional zoning that was typical of modernist urban 
planning, where different parts of the city were assigned specif-
ic functions such as housing, work, or commerce. The result is a 
system with limited integration between functions. 

•	 In a network structure, on the other hand, street segments are 
more evenly distributed and more mutually integrated. This allows 
for greater accessibility and mixing of functions, which often 
promotes urban life, interaction, and flexibility in the use of urban 
space.

Carmona (2021, p. 203) also emphasizes how urban morphology 
affects people’s movement and choices. An important factor is the 
connectivity of the street network, how the city’s street network is 
interwoven, which determines the ability to create context and move-
ment opportunities. Carmona highlights two important dimensions of 
accessibility:

•	 Visual: How clear the route choices are
•	 Physical: The actual possibilities for movement

Carmona (2021, p. 206) argues that a fine-mesh street network with 
small blocks provides more route choices and makes it easier to find 
your way around the city. This is also related to the fact that long 
blocks often lead to detours that lack functional meaning, while a 
street network with a high density of intersections helps to connect 
neighbourhoods and create natural flows (Jacobs 1961, pp. 179-180). 
The report “Mäta stad” (Measure city) emphasize that at least 150 
street intersections per square kilometre is a good benchmark for 
good connectivity (Spacescape 2016, p. 38). This also affects the size 
of neighbourhoods, which on average should not exceed 7,000 square 
metres which corresponding, for example, to 84 x 84 metres or 50 x 
140 metres.

Furthermore, street layouts do not change often but tend to remain 
the same over time (Carmona 2021, p. 234). On the other hand, land 
use and city life are changing at a faster pace, so it’s important that 
the built environment and street network can accommodate this 
change. This can be achieved by creating structures that tolerate 
changes in function by avoiding overly functional zoning and allowing 
for flexibility where the built environment can adapt to new needs. 
Modernist urban planning is a counterexample to this, where the 
separation of functions has created areas that are difficult to convert 
when society’s needs change (Marcus 2022, p. 173).

The theory of natural movement suggests that the configuration of 

Figure 7: J-graphs

Figure 6: Tree and network structure
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tween built-up and undeveloped land in the model’s graph. 

The model provides a more holistic picture of building density and 
makes it possible to compare the density of cities, identify typical 
density patterns (traditional neighbourhoods or modernist high-rise 
areas), and evaluate different planning proposals by analysing their 
density and the effects it may have on the urban environment. The 
analysis can be performed at different scales: plot, island, fabric, 
district. Depending on the scale, different results are also generated in 
the model, where smaller scales such as parcel and block often gen-
erate higher fsi and gsi than in higher scales such as fabric and dis-
trict. This is important to consider when comparing different density 
analyses.

Another way to measure building density is accessible FSI & GSI, 
which measures how much built-up area is accessible from a specif-
ic location (Marcus & Berghauser Pont 2022, p. 18). Measuring only 
FSI and GSI within a defined area provides a vague picture of how the 
city’s density affects the experience and use of a place. Measuring 
accessibility-based metrics instead provides a greater understand-
ing of the urban context and the place’s relationship to the rest of the 
city. According to Marcus & Berghauser Pont (2022, p. 18) this enables 
questions such as: “If I am standing here, what can I reach within a 
ten-minute walk?”.  In this way, the city’s form and spatial organiza-
tion have a direct impact on how density is perceived and functions.

Aspects that promote diversity and closeness
A finely divided property structure enables a wider range of property 
uses, thereby promoting diversified land use (Marcus 2022, pp. 41–
43). For instance, one housing association may prioritise low monthly 
costs for its apartments, whereas another may prefer to have a restau-
rant or shop on the ground floor. When ownership is divided between 
several parties, the area becomes more resilient to change. If a compa-
ny moves or closes, the effect is limited to a smaller area.

Marcus (2010, pp. 36-38) links this to what he terms “spatial capaci-
ty” and “capital’” Spatial capacity refers to access to properties, that 
is, how many properties can be reached from a given point, area or 
street segment. Spatial capital, on the other hand, is defined as the so-
cio-spatial value generated by the urban form. Spatial capital has both 
an exchange value, for example land or property values, and a use 
value, such as social, cultural and environmental benefits for everyday 
urban life. This concept emphasises that cities provide spatial capital 
by enabling access to different uses and functions, thereby promoting 
social, cultural and economic development.

A finely divided property structure is particularly relevant in city 
centres, where land values are high. Dividing plots into smaller prop-
erties lowers financial barriers, enabling a broader range of investors 
and entrepreneurs to participate. In opposition, large properties limit 
ownership to those with higher capital, reducing the variety of uses 
and thereby limiting urban diversity.

Another important aspect is land use in the city. A vibrant and diverse 
city requires not only concentrated development, but also efficient 
and diversified land use. Jane Jacobs (1961, pp. 214-217) highlights 
Greenwich Village in Manhattan as a model for vibrant urban life. 
According to Jacobs, a key factor is how land is allocated. In this area, 
60 to 80% of the neighbourhood is occupied by residential buildings, 
while the remaining 20 to 40% is used for courtyards and common 
areas. This high proportion of buildings, according to Jacobs, enables 

Figure 9: Building typologies with the same 
GFA density (Berghauser Pont., Haupt  
2023)

Figure 10: Space matrix (Berghauser Pont., 
Haupt  2023)

Figure 11: High centrality and density 
related to mixed-use urban areas (Nes., 
Berghauser Pont., & Mashhoodi, 2012)

character of a city. Jane Jacobs (1961, p. 201) argues that sufficient 
population density is a necessary foundation for creating a vibrant and 
diverse city. According to Jacobs’ analysis, a certain level of density is 
required to enable economic diversity, as there must be enough res-
idents to support various activities and functions in the city. A larger 
population also provides a basis for creating flows in the city and thus 
promoting social interaction, as this is one of the cornerstones of 
spontaneous encounters and community.

At the same time, too low or too high a population density can have 
several negative consequences. If it is too low, it limits the availability 
of services and cultural offerings, public transportation, and walkabil-
ity, and risks leading to fragmented urban spaces with poor resource 
management. An urban form associated with low density is known as 
“urban sprawl,” where large residential areas spread out over large 
areas of land (Rafferty, n.d). This urban form has often led to great-
er car dependency due to the population base for well-functioning 
public transport becoming too low, a lack of public meeting places, 
and higher resource use. Excessive population density can instead 
lead to increased congestion and stress among residents, which risks 
increasing mental ill health and excessive pressure on public spaces 
and green areas. In addition, research shows that high-rise buildings 
often lead to lower population density than medium-density, dense 
neighbourhood development (Salat 2021, p. 2). High-rise buildings 
require wider streets, larger technical spaces (elevators, ventilation), 
and more undeveloped land around the buildings. For example, Paris, 
with its 6-7-story buildings in continuous neighbourhoods, achieves 
the same density as parts of Manhattan.

There are different guidelines for what is considered a reasonable 
population density. For example, UN Habitat’s report on strategic 
densification compares the population density of ten cities ranked 
among the top 10 in several liveability indexes (Salat 2021, p. 7-11). 
The benchmark shows that sustainable density is usually between 
12,000 and 14,000 people/km2, but that it can vary between 4,700 and 
24,000 people/km2. At the same time, the report emphasizes that it is 
important for density to be context specific. Density does not neces-
sarily have to be the same as in the surrounding area, but new build-
ings must respect their surroundings in terms of scale, design, and 
typology.

Population density depends on building density, which can be meas-
ured in several different ways. Common measures are gross floor area 
and floor space index. Gross floor area is the sum of the size of all 
floors, that is, the total built area. The floor space index is a measure 
where the gross floor area is divided by the size of the surrounding 
area, for example, the property area. The measure can also be used at 
the neighbourhood level to get a bigger picture of the density of the 
area. It is calculated by dividing the gross floor area of the buildings 
in the neighbourhood by the land area on which the neighbourhood 
stands plus half of the surrounding street space.

However, both gross floor area and floor space index are vague meas-
ures of density, as they do not say anything about the typology or 
design of the buildings (Berghauser Pont & Haupt 2020, pp. 7-11). This 
is a clear weakness when areas are developed after achieving a certain 
gross floor area or floor space index, as these can be achieved in sever-
al separate ways, as illustrated in Figure 9. The Space Matrix model 
can provide a more comprehensive picture. The model combines the 
floor space index with the building area (the building’s footprint on 
the ground), which also shows the number of floors and the ratio be-
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watercourses are examples of core values. A key biotope that is com-
mon and important in urban environments is “valuable trees,” which 
refers to giant trees, very old trees, and large hollow trees.

Dispersal zone
Dispersal zone refers to the range of a species from its core area where 
it is likely to spread. The dispersal zone varies between species and 
habitats, but a guideline for the dispersal zone is between 0-2 km.

Dispersal corridor
A dispersal corridor is an area with a habitat that can serve as a corri-
dor between different core areas for a species, thereby increasing the 
dispersal zone. When several core areas are connected so that species 
can spread between them, this creates what is known as a value net-
work.

Barriers
Barriers are different land uses or habitats that are obstacles in a spe-
cies’ dispersal zone or corridor. These can include water areas or hard 
surfaces such as roads, buildings, and parking lots. 

Green spaces and greenery in cities are not only important for eco-
systems, but also for our psychological and mental health. Research 
shows that access to everyday nature experiences have a positive 
impact on public health, as for example helps lower blood pressure, 
slow the heart rate, and reduce levels of the stress hormone cortisol 
in the blood. It also helps strengthen short-term memory and prevent 
dementia. Green areas encourage physical activity, which in turn helps 
prevent obesity, cardiovascular disease, diabetes, and mental illness 
(Boverket 2022).

Spacescape (2016, pp. 23-33) has compiled guidelines for access to 
green spaces and parks based on urban analyses and reports from 
municipalities, the Swedish National Board of Housing, Building and 
Planning, and the Norwegian Environment Agency.

•	 Green areas
Public green areas of at least 0.2 hectares must be accessible within 
200 meters.

•	 Park
A maximum distance of 500 meters to a park area that is at least 1 
hectare and 50 meters wide. The park area must have a flat grassy area 
of at least 0.5 hectares.

Giant trees 
Living or dead trees that are thicker than 
one meter in diameter. 

Very old trees
Living or dead spruce, pine, oak, and 
beech trees that are older than 200 
years. Other tree species that are older 
than 140 years. 

Hollow trees
Living or dead trees with developed 
cavities and a trunk diameter greater 
than 40 centimetres.

Core habitat

Dispersal zone

Dispersal corridor

Barrier

Local scale

The street – a central part of public life
It is on the streets of a city that much of urban life takes place, and 
they constitute a large part of the city’s public spaces (Ståhle et al 
2020, p. 150). Streets have several important functions in the city: they 
are central to how we move around, they create flows of people that 
can generate social and economic activities, and they can also provide 
space for green corridors in the city and manage storm water. The 
city’s technical infrastructure, such as culverts, district heating, and 
fibre, often runs beneath the streets.

Since the 1950s, cars have become increasingly dominant in the street 
space, leading to monotonous spaces without social, economic, or 

intensive land use, which means that buildings do not need to be used 
intensively but can accommodate a variety of functions. A more inef-
ficient use of land, with larger open spaces and fewer buildings, would 
lead to a more inefficient use of land. Each building would then have 
to be used more efficiently, which often limits its use to residential 
purposes at the expense of other activities.
At the same time, Jacobs warns that excessive building density can 
create rigid and unattractive environments unless the buildings are 
balanced with well integrated streets, squares, and green spaces.  

Ecosystem services and biodiversity
Ecosystem services are benefits and resources provided by nature 
that support the life and well-being of plants, animals, and humans 
(Naturvårdsverket, 2024). Ecosystem services are divided into four 
categories:

- Provisioning services, such as food and water.
- Regulating services, such as climate regulation and water purifica-
tion.
- Cultural services, such as recreation and aesthetic values.
- Support services, such as nutrient cycling and soil formation

Some ecosystem services are essential to our life on Earth, such as 
how trees and plants capture carbon dioxide and provide us with oxy-
gen, or how pollination enables us to produce fruit and vegetables. In 
cities, ecosystems have both visible and invisible consequences. For 
example, trees provide shade during heat waves, and parks can act as 
floodplains during heavy rainfall. At the same time, the ecosystems 
behind services are often complex, with several different underlying 
interactions and mutual dependencies between animals and plants 
that are crucial to the functioning of the ecosystem. The Swedish 
Environmental Protection Agency (Naturvårdsverket 2024) describes 
ecosystems as a web in which every animal or plant is a thread. If the 
threads disappear, the net is eventually destroyed. In the same way, 
our ecosystems are affected or destroyed when species and plants 
disappear, which is why species diversity is important for creating 
stability. Biodiversity is therefore a vital part of promoting ecosystem 
services and ensuring that they are viable. To promote biodiversity 
and create robust ecosystems, it is important to create a rich variety 
of habitats in cities and to create connected green spaces, known as 
green infrastructure.

Green infrastructure
When the city’s various green areas are connected and form networks, 
this is referred to as green infrastructure (Boverket 2023). It is there-
fore important to map important habitats, green contexts, and quali-
ties in the city. In this way, different measures can be assessed so that 
the right measures are implemented in the right place. To ensure this, 
the green structure must be analysed on a larger scale to create an 
understanding of the various systems as a whole. The measures must 
also be adapted to the type of habitats and species distribution to be 
promoted. Green infrastructure can be divided into different catego-
ries, but four important categories are core values, dispersal zones, 
dispersal corridors, and barriers.

Core values are areas or places with particularly high natural val-
ues and are a central part of several ecosystems. One of the rea-
sons for this is that they are often habitats for species to reproduce 
(Naturvårdsverket 2017, p. 3). In Sweden, classifications such as key 
biotopes, biotope protection, and regionally and nationally valuable 

UN-Habitat proposes the following 
guidelines for balanced land use (Salat 
2021):

•	 Housing: 25%
•	 Community services/economy: 

25%
•	 Streets: 25–30%
•	 Parks & open spaces: 20–25%

Spacescape (2016, pp. 23-33) has 
supplemented this with additional 
guidelines for land use. They believe that 
public spaces should meet the following 
criteria:

•	 At least 15% of the total land area 
(of which 10% should be green 
areas and 5% parks).

•	 10 m² of public space per resident, 
a level that has passed the accessi-
bility and load test.
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Figure 12: Relation between quality of envi-
ronment and activities (Gehl 1996, p. 11-14) 

Jan Gehl’s (2010, p. 249) 12 criteria for a human centric urban development.
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•	 In order for a city to offer a variety of activities, it needs a variety 
of building types, different sizes, shapes, and spatial qualities. Sim 
emphasizes the importance of avoiding homogeneous large scale 
buildings and instead promoting a mix of small and medium sized 
properties. 

•	 A diversity of outdoor environments, where different types of 
public and private spaces create opportunities for varying uses and 
needs. 

•	 Flexibility, because cities are constantly changing. The built 
environment must therefore be adaptable and responsive to new 
demands over time. 

•	 By designing the city on a human scale, taking into account micro-
climate, convenience, and experiential values, places are created 
that encourage people to stay and interact. Density should be de-
signed to promote human well-being rather than efficiency alone. 

•	 Walkability is another key principle, where a well connected street 
structure with good accessibility facilitates movement between 
different places. 

•	 Finally, the city needs to offer a sense of control and identity 
through clearly defined places with a distinct character. This not 
only supports orientation but also contributes to a sense of be-
longing and place identity.

Quality of the physical
environment

Necessary 
activities

Optional 
activities

Social 
activities

GoodPoor•	 Pedestrian street
This type of street is designed so that 
all types of traffic move on the same 
surface at a speed of between 5 and 
10 km/h. This type of street should be 
prioritized in cities as it creates several 
added values and is both multifunctional 
and flexible. Walking streets are suita-
ble when there is a demand or need for 
people to spend time in an area and 
can therefore be suitable for residential 
areas, shopping and activity streets, and 
near schools, sports facilities, or parks.

•	 Low-speed street
Low-speed streets are designed so 
that vehicles must travel at low speeds, 
max. 20 km/h. Pedestrians move and 
stay on separate pedestrian areas and 
in flexible areas. Vehicles travel on the 
carriageway in the middle and can pull 
over onto the carriageway or into flex-
ible areas. Low-speed streets are also 
known as bicycle streets or cycle streets. 
Important aspects of the design include 
even and permeable road surfaces, 
wide bicycle lanes, frequent crossings, 
and several flexible and green areas.

•	 Multi-speed street
The design of multi-speed streets is 
based on the inner carriageways being 
adapted to a higher speed (40 km/h) 
while the outer ones have a lower 
speed (20 km/h). The carriageways in 
the middle are reserved for public trans-
port, while cars and cyclists share the 
outer ones. Pedestrians are directed to 
pedestrian and flexible areas. This type 
of street allows for large-scale public 
transport and has greater capacity for 
vehicle flows.

•	 High-speed street
The high-speed road is designed so 
that vehicles can travel at higher speeds 
(max. 40 km/h). Public transport runs in 
the middle, while cyclists travel on sepa-
rate lanes. Esplanades, where pedestri-
an and bicycle traffic are concentrated 
in the middle, are not recommended as 
they become inaccessible and make it 
difficult to change traffic patterns.

cultural exchanges (Camrona 2021, p. 241). Where cars have taken over 
the street space at high speeds, this has often led to the creation of a 
monotonous space without social, economic, or cultural exchanges. 
A high proportion of car traffic and increased speeds in public spaces 
tend to weaken the social potential of places. When car traffic dom-
inates, opportunities for spontaneous interactions decrease, while 
streets with lower speeds create conditions for a richer urban life. Ac-
cording to Jacobs (1961, p. 148), slower traffic environments promote 
both social and economic exchanges, as pedestrians and cyclists can 
more easily stop, observe their surroundings, and participate in public 
life.

These types of environments often become attractive hubs, not only as 
destinations in themselves but also as part of larger movement pat-
terns. People are often drawn to places with high levels of activity and 
opportunities for “people watching”, a form of passive social interac-
tion that strengthens the connection to the city. Such places serve as 
both destinations and thoroughfares, further enhancing their impor-
tance to urban life.
Several major players in urban planning in Sweden have jointly com-
piled the report “Smarta gator” (Smart streets). The report explores 
how street spaces can be transformed in terms of their function and 
design to create better social, traffic, ecological, economic, and tech-
nical conditions (Ståhle et al 2020). The report categorizes roads into 
four different types and highlights important aspects of their design, 
key requirements, how they can be adapted to different contexts, and 
suitable intersection types.

Aspects in the built environment that promotes social life
According to Jan Gehl’s (1996, pp. 11-14) research, human activities in 
urban environments can be categorized into three basic types:

•	 Mandatory activities
Basic movements and commitments such as commuting to work and 
school. Performed regardless of the quality of the environment be-
cause they are necessary

•	 Voluntary activities
Recreational and pleasure-oriented activities such as walking or 
visiting a café. These require attractive public spaces and favourable 
external conditions such as a good microclimate and accessibility.

•	 Social interactions
Spontaneous encounters and conversations that arise when people 
find themselves together in urban spaces, which is a secondary effect 
of the first two types of activities.

Gehl (1996, p. 11-14) highlights a clear link between the design of the 
physical environment and activity patterns, where under stimulat-
ed public spaces limit use to only necessary activities. Well-designed 
urban spaces, on the other hand, encourage mandatory, voluntary, 
and social activities and interactions. Based on his observations and 
studies, Gehl (2010, p. 249) has developed twelve design principles for 
people-centered urban design that can promote voluntary activities 
and social interactions.

In his book Soft City, architect David Sim (2019, pp. 290-305) also 
presents nine urban design criteria for creating more vibrant and ad-
aptable cities. Six of these criteria are particularly relevant for under-
standing how the built environment can interact with various system 
effects:
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Figure 13: Relation between the usage of 
courtyard and the sense of control and size 
(Minoura 2016) 

Figure 14:  Relation between the capacity 
and the sense of control of a courtyard 
(Minoura 2016)  

“Uncommon Ground Urban Form and Social Territory,” Minoura has 
investigated how spatial elements interact to create territorial struc-
tures in urban spaces, with a particular focus on residential court-
yards. The study shows that a high degree of territoriality is related to 
an increased sense of control for users, which strengthens their sense 
of belonging and security. The size of residential courtyards also re-
lates to their capacity for different functions, activities, and uses.

In hers study, Minoura (2016, pp. 338-342) develops an understanding 
of how different building typologies relate to degrees of territorial-
ity and identifies design principles that can strengthen the function 
and perceived sense of belonging of residential courtyards. The study 
shows that spacious courtyards, with a benchmark of 10 to 12 square 
meters of courtyard space per 100 square meters of gross floor area, 
tend to be used more often and by more residents. However, unclear 
boundaries between private and communal spaces lead to fewer signs 
of use and can be linked to an increased feeling of insecurity. Clear 
framing of the courtyard, on the other hand, strengthens both security 
and a sense of belonging.

Courtyards that are used as thoroughfares often lose both their use 
and their identity, which should be avoided. At the same time, court-
yards that leave room for residents’ own initiatives, the “unfinished”, 
can encourage engagement, provided that basic spatial qualities such 
as size, clarity, and space are in place.

Three key factors that influence the usability and attractiveness of 
courtyards are:

•	 The design of the interface, and the degree of openness (fences, 
vegetation)

•	 Spatial proportions, where a balance between space and density 
plays an important role

•	 Functional diversity, which enables different types of use and 
strengthens the social life of the place.

The building typology affects the wind patterns and thus also the microclimate of its surroundings 
(Esch 2015, pp. 161-165; Du & Zhu 2023, p. 2). 

Lively ground floors
In her thesis “Walls of the Public Realm,” Johanna Gimfjord Nielsen 
(2023) examined important aspects of creating lively ground floors, 
especially in areas where commercial activity is not possible. First, she 
looked at different morphological structures and relative locations in 
the system and related them to suitable functions, then assessed im-
portant aspects of the facade design to support these functions.

Permeability Transparency
Public	 Easy accessible

Large and clear entrances
High transparency
High degree of glazed facade

Semi-public Directed access
The accessibility is di-
rected towards specific 
groups as working places 
and schools

Visual exchange
The façades enable a visual ex-
changes between the inside of the 
building and the street. Functions 
such as workplaces are protected 
from insight.

Private Restricted access 
The accessibility is restrict-
ed to only but a few, as 
housing

Transparency but no visual 
exchange
The façades allow for daylight 
and sight lines but does not allow 
insight

Blank Impermeable
Function that are not used 
regularly, such as a emer-
gency exit.

No connection
Storage, parking

Territoriality and courtyards
Another important aspect of urban space concerns territoriality and
the interface between private and public land (Minoura 2016, p. 13-14). 
Territoriality refers to the claim of an individual or group to a space. 
Moving through the city involves a constant process of interpreting 
territorial markers, where not only the presence of people but also 
physical elements such as furnishings, boundaries, and vegetation 
signal the social values and usage patterns of places. In her study 

Strategies for façade design strategies 
(Gimfjord Nielsen 2023, pp. 59-60):

•	 Soft boundaries
Carefully designed boundaries or buff-
ers between public and private spaces
•	  Rhythm
 Break up the façade into smaller 
sections
•	  Diversity
Create variation in the design of the 
façades to create a more stimulating 
street environment
•	 Affordance
Façades that create affordance by 
enabling physical interaction, such as 
seating.

Demand for movement
High: retail, serving
Mid-high: Services, cultural, exercise
Mid-low: Public functions, occupational
Low: Accommodation, utility, logistics

Permeability
Permeability refers to how accessible the 
interior of the building is from the street, 
which affects the interaction between 
the street and the building.

Transparency
Transparency refers to the visual con-
nection between the ground floor and 
the street.

Angled roof pitches 
prevent the wind from 
bouncing sideways

A deformed grid can 
break wind tunnels

Greenery and trees 
are also effective 
wind breakers

Closed blocks create 
wind-protected court-
yards

Blocks with different 
building heights pre-
vent wind circulation 
inside the courtyard.

A varied silhouette 
hinders the wind 
from being pushed 
downwards by higher 
buildings.

Broken or offset 
façades create 
wind-protected areas



Population density

UN Habitat has identified a population 
density of 12 000-15 000 residents / km2  
as a mean value for cities with the highest 
liveability index in Europe (Salat 2020). 
They emphasises the importance of the local 
context in order to achieve sustainable pop-
ulation density. Spacescape (2016) argues 
that this population density may be difficult 
to achieve on a larger scale, but believes it 
is desirable within 800 m walking distance 
of a major public transport hub.

Positive
•	 Dense urban structure, can promote 

city life and urban qualities.
•	 Clear interface between public and 

private spaces

Positive
•	 More open spaces, providing good 

opportunities for recreation through 
parks, gardens, greenery, and better 
natural storm water management.

HighLow

Negative
•	 Risk of insufficient space for green 

spaces, play areas or recreation.
•	 Risk of poor storm water management 

and increased heat island effect.
•	 May reduce opportunities for flexibility 

in land use.

Negative
•	 Inefficient use of space.
•	 Weak urban identity and difficulty in 

creating urban environments.
•	 May make it difficult to create pedestri-

an- and bicycle-friendly environments if 
buildings are sparsely located.

Ground Space Index (GSI)
Shows how much land is occupied by build-
ings. As with FSI, the Accessibility to GSI can 
also be a good way to investigate the local 
context.

Positive
•	 Efficient land use
•	 Enables high population density, which 

supports higher flows, public transport 
and local services.

Positive
•	 Sparsely populated and quieter resi-

dential environments with larger private 
spaces.

•	 Better access to greenery, daylight, 
and air.

HighLow

Negative
•	 Risk of congestion, lack of green spac-

es and daylight if paired with high GSI.
•	 Can create a feeling of anonymity and 

large scale.
•	 Requires more advanced infrastructure 

(sewage, transportation, ventilation).

Negative
•	 Inefficient land use, may lead to urban 

sprawl.
•	 Difficult to provide the area with public 

transport or local services.
•	 May contribute to increased car 

dependency

Floor Space Index (FSI)
Measures the volume of the building in re-
lation to land use. To generate a population 
density of 15000 residents / km2, which 
UN Habitat has identified as a mean value 
for cities with the highest liveability index in 
Europe, an FSI of 2.0 on block scale (Salat 
2021; Spacescape 2016). UN-Habitat 
emphasises the importance of starting from 
the local context in order to achieve sus-
tainable densification. This can be achieved 
by examining accessibility to FSI within a 
certain radius.

System

Positive
•	 Better population base for public trans-

port, shops, schools, and culture.
•	 More movement, better conditions for 

social interaction.
•	 Shorter distances and opportunities for 

sustainable transport solutions.

Positive
•	 Quiet and low stress: A more peaceful 

living environment with less traffic and 
noise.

•	 More space per person: Larger private 
plots, more greenery, easier access to 
nature.

Negative
•	 Risk of congestion: Risk leading to 

increase stress, noise, and competition 
for public spaces.

•	 Pressure on infrastructure: Sewage 
systems, transportation, and healthcare 
may become overburdened.

Negative
•	 Inefficient land use: May lead to urban 

sprawl and higher infrastructure costs.
•	 Increased car dependency: Long 

distances make walking, cycling, and 
public transportation less attractive.

•	 Weak service base for local business-
es, schools, and public transportation.

Low High

04. Design framework
This chapter summarises a design framework 
based on the key aspects identified in the 
theory chapter. The framework is intended 
to serve as a guide to designing and as-
sembling different configurations to achieve 
and reinforce desirable system effects. It 
also highlights potential conflicts within and 
between different design elements.



Microclimate
Wind is often the most problematic aspect 
of creating a comfortable microclimate. A 
sunny February day can be pleasant out-
side if it’s no cold wind and a rainy summer 
day will be more bearable if it’s not windy.
 
The building typology affects the wind 
patterns and thus also the microclimate of 
its surroundings (Esch 2015, pp. 161-165; 
Du & Zhu 2023, p. 2).

Angled roof 
pitches prevent 
the wind from 
bouncing side-
ways

A deformed 
grid pattern 
can break wind 
tunnels

Trees and 
greenery are 
also effective 
wind blockers

Closed blocks 
create wind-pro-
tected court-
yards

Blocks with dif-
ferent building 
heights prevent 
wind circula-
tion inside the 
courtyard.

A varied silhou-
ette hinders the 
wind from being 
pushed down-
wards by higher 
buildings.

Broken or offset 
façades create 
wind-protected 
areas

Local

Facade & Lively ground floor
In her master’s thesis, Johanna Gimfjord 
Nielsen (2023) has investigated how 
ground floors can be programmed 
based on function, demand of flow, 
transparency, and permeability.

To create flexibility between apartments 
and facilities, the ground floor ceiling 
height can be raised to 4 meter.

At least 5 entrances per 100 m in 
mixed-use developments (Spacescape 
2016).

Function

Public

Semi-public

Private

Transparency

Full exposure

PublicRetail, serving

Semi-publicSchools, 
Workplaces

Private
Accommodation

No visual connec-
tion

Demand of flow

High

Mid-high

Mid- low

Low

Retail, serving

Care, culture, 
services, exercise

Gatherings, public 
functions, occupa-

tional

Public

Semi-public

Private

Ex emergency exits

Visual exchange

Visibility, no ex-
posure

Enclosed

Permeability

Open access

Addressed access

Restricted access

Impermeable

Accommodation, 
utility, logistics

Enclosure & courtyards
Higher enclosure can increase the user’s 
sense of control and belonging to the place. 
Minimum courtyard size 1500 m2, ideally 
between 3000 too 4000 m2 (Minoura 
2016).

Individual ownership: High (85-100 %)
Collective ownership: Minimum 85%
Collective ownership and use :Minimum 85%
Collective use: Flexible
Use (Public): Low (0-20 %)

Streets 
The following street types are based on 
the guide “Design guide för smarta gator” 
(Design guide for smart streets) (Ståhle et 
al., 2022): 
 
- Pedestrian street (highest priority) 
- Low-speed street  
- Multi-lane street 
- High-speed street (lowest priority)

Low High

Positive
•	 Easy navigation: Areas are easier to 

reach with fewer direction changes – 
intuitive for users.

•	 High pedestrian traffic: beneficial for 
retail and social activities.

•	 Natural surveillance: More people can 
increase safety by “keeping an eye on 
the street.”

Positive
•	 Privacy and tranquillity: Suitable for 

residential areas, parks, or retreats.
•	 Controlled access: Useful in areas 

requiring security or limited flow (e.g., 
private campuses, sensitive facilities).

•	 Character and exploration: Can create 
a sense of mystery or uniqueness, often 
seen in historic urban environments.

Negative
•	 Congestion: High integration can lead 

to overcrowding and traffic (vehicles or 
pedestrians).

•	 Lack of privacy: Overly exposed spac-
es may be unsuitable for residential or 
contemplative purposes.

•	 May increase noise and pollution

Negative
•	 Poor accessibility: These areas can be 

harder to find or get to, which can lead 
to underused or neglect.

•	 In large areas they can led to isolation, 
social exclusion or crime if they’re too 
secluded.

•	 Economic decline: lack of customer 
footfall.

Betweenness centrality 
It is often measured at local (neighbour-
hood) scale using a 2 km analysis, and at 
global (city) scale using a 5 km analysis. 
 
Betweenness centrality shows through 
movement, while integration centrality shows 
to movement. 
 
If the same street segment has a high be-
tweenness centrality value at both local and 
global levels, it is possible to meet people 
from all over the city in the same place, 
thereby increasing co-presence.

Positive
•	 Capacity to accommodate space 

demanding such as industry, logistics or 
food stores

•	 Can provide a certain degree of 
flexibility

Positive
•	 Enables more economic efficient land 

use, as the land is divided into smaller 
units.

•	 Higher property density, opportunities 
for increased mixed use.

LargeSmall

Negative
•	 Tend to reduce urban mixed use, as 

larger units are often dominated by a 
single function.

•	 Higher price per unit.

Negative
•	 May pose challenges in the coordi-

nation of larger urban development 
projects or infrastructure investments.

•	 Cannot accommodate space-intensive 
activities.

Plots
A finely divided property structure enables a 
wider range of property uses, thereby pro-
moting diversified land use (Marcus 2022, 
pp. 41–43; Marcus 2010, pp. 36-38). 
Marcus links this to what he terms “spatial 
capacity”, which refers to how many prop-
erties can be reached from a given point, 
area, or street segment. This in turn impact 
the “spatial capital”, which Marcus mean is 
defined as the socio-spatial value generat-
ed by the urban form. 

Land-use
The following thresholds are suggested for 
creating a good balance between different 
land uses (Salat 2021; Spacescape 2016).
Housing: 25%, Community services/econ-
omy: 25%, Streets: 25–30%, Parks & open 
spaces: 20–25%
 
Public spaces should meet the following cri-
teria: At least 15% of the total land area (of 
which 10% should be green areas and 5% 
parks). 10 m² of public space per resident 
(Space Scape 2016, pp. 23-33) 

Green structure
Green areas
Public green areas of at least 0.2 hectares 
must be accessible within 200 meters. 

Park
A maximum distance of 500 meters to a 
park area that is at least 1 hectare and 50 
meters wide. The park area must have a flat 
grassy area of at least 0.5 hectares.

Street network
150 junctions / km2
Distance between junction: 50-150
High permeability for pedestrian and cyclist

Tree structure: A main line with branches 
leading to separate zones for specific 
functions (housing, work), resulting in limited 
integration. 

Network structure: Evenly distributed, inter-
connected streets, enabling better accessi-
bility, functional mixing.



DESIGN FRAMEWORK

Analyse the context through 
spatial analyses and theoretical 
frameworks to create an under-
standing of the current context 
and to highlight different system 
conditions 

Risks and potentials are identified 
for the site based on its system 
conditions and morphological 
attributes. A vision is formulated for 
how the site could be developed 
to generate positive system effects 
and to mitigate conflicts between 
social and ecological aspects. 

Test and evaluate spatial configurations using analyti-
cal methods to ensure the design hold the potential to 
fulfil the vision.

Match system configuration with 
local design that enhance positive 
system effects and mitigate so-
cial-ecological conflicts

Develop an analytical understanding of urban morpho-
logical elements. This refers to how the underlying spatial 
principles affect function and use.

Analytical understanding

Context

Identify potentials

Reconfigure, test, evaluate

Match with 
coherent design

Habitat parameters for bees
(Berghauser Pont et al, 2022)
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Human oriented cities
Based on the works of Jan Gehl (1996; 
2010), David Sim (2019), and Carmona 
(2010) the following aspects could foster 
a greater human well-being in the built 
environment.

Scale

Visual connection

Walkability

Protection against 
traffic

Positive impact on 
senses

Opportunities for recre-
ation and activities

Ability to sit

Micro climate

Being able to talk 
and hear

Ability to stand

Protection against 
criminality and 

violence

Protection against 
unpleasant impact 

on the senses

D
el

ig
ht

C
om

fo
rt

Pr
ot

ec
tio

n

2:1 1:1 1:2

 >2:1 is The street feels 
very wide and expansive. 
Very low enclosure where 
pedestrians may feel 
exposed. More likely to 
be auto-oriented, with 
reduced human scale.

 A ratio of 2:1 feels open 
and spacious. It has a ow 
sense of enclosure – the 
sky dominates the view. 
May reduce walkabil-
ity and comfort unless 
well-landscaped.

 A ratio of 1:1 is often 
considered the minimum 
for comfortable urban 
streets. A street wall height 
that equals the street 
width severely limits any 
sky view and gives a 
strong sense of enclosure.

If the ratio is 1:2 the sky 
equal the amount of visual 
field devoted to the street 
wall. Provides a good 
sense of enclosure in a 
street.

>1:2.5. May cause 
feelings of claustropho-
bia and will reduce light 
penetration. Can create 
dramatic contrast com-
bination with other street 
profiles.

Ratio between street width and building height

Design considerations

Design of building 
façades at eye 

level to stimulate 
experience

Boundaries be-
tween public and 

private

Connection between the 
building and the street. 
Floors above the fifth 
floor have a reduced 

connection.

The interaction 
between the inside 
and outside of a 

building 
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Trädlyckevägen

Österängsvägen

Västkustvägen

Varberg is a coastal city located 
in Halland County, on the west 
coast of Sweden, approximately 
75 kilometres south of Gothen-
burg and 140 kilometres north 
of Malmö. The municipality has 
a population of around 65,000 
inhabitants, where around 36 
00 live in the city. Varberg has 
become a know destination for 
tourism, wellness, and com-
merce. 

The current strategy in Varberg 
(2018) for urban development is 
densification, partially to protect 
the surrounding farmland, par-
tially to add new values to already 
built-up areas. The densification 
plan has three priority strate-
gies that propose different areas 
for densifying the city with new 
housing, services, and facilities:

•	 Develop Västerport to a mix 
use urban district.

•	 Transforming Trädlyckevä-
gen and Österängsvägen to 
create urban corridors.

•	 Densify near local squares.

Land-use map

The land-use map shows the 
current extent of Varberg’s urban 
area. The city centre is still made 
up of closed blocks dating back to 
the city’s beginnings, while the 
built-up area is gradually becom-
ing less dense and turning into 
villa areas with an urban sprawl 
character. The populated areas 
Varberg is mainly surrounded 
by high quality farmland. This 
imposes challenges for Varbergs 
future development, as the farm-
land is seen as a natural resource 
and is of national importance, 
therefore a hindrance for urban 
extension.

Context

05. Context
In this chapter the context of Var-
berg is explored a variation of spatial 
analysis.
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1000 m750 500 2500

1000 m750 500 2500

Motorized angular betweenness,  
2km

Motorized angular betweenness, 
5km

The map shows the motorized 
betweenness centrality on a glob-
al (city) scale. The analysis shows 
a clearer hierarchy than the other 
maps, where two prominent roads, 
Ringvägen and Österängsvägen, 
have high centrality and meet in the 
center of the city.

The map shows the motorized 
betweenness centrality on a local 
(neighbourhood) scale. The analysis 
shows that the route from Ringvägen 
up to Föreningsgatan is a segment 
with high frequency for motorized 
traffic. This also coincides with the 
analysis for non-motorized between-
ness centrality on the same scale.

1000 m750 500 2500

1000 m750 500 2500

Angular betweenness, 2km

Angular betweenness, 5km

The analysis shows betweenness 
centrality at a global level. Here, 
Västra Vallgatan/Birger Svenssons-
väg has a higher centrality in the city 
centre. At the same time, Magasins-
gatan still has a high centrality, while 
Ringvägen disappears. Instead, 
Föreningsgatan is reinforced, which 
then leads on to Södra Vägen in the 
south and Österleden in the east.

The analysis shows the betweenness 
centrality on a local scale. In the 
centre, there are several similar street 
segments, which means that none of 
them stand out. Outside the centre, 
Ringvägen and Magasinsgatan 
have higher centrality, which is then 
connected via Föreningsgatan.
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1000 m750 500 2500

1000 m750 500 2500

Sqm of floorplan area within 1km

Access to population within 1km

The map shows how much ground 
floor that can be reached from each 
building. The analysis shows highest 
level within the city centre with a few 
hotspots dispersed in the city.

The map shows how much of the 
population that can be reached from 
each building. The analysis shows 
highest level within the city centre 
that stretches out towards the south 
and north east. In the middle of the 
city, along Österängvägen, there’s 
a lower value then the surrounding 
areas. This can be explained by that 
a large hospital is located there.

1000 m750 500 2500

1000 m750 500 2500

Angular integration, 2km

Angular integration, 5km

The map shows integration centrality 
at a global level. The analysis shows 
that the whole city is well integrated.  

The map shows integration centrality 
at a local level. The analysis shows 
that the central parts of the city are 
well integrated, with integration de-
creasing towards the outskirts. There 
are no major areas with low integra-
tion within the city.



38 39

1000 m750 500 2500

1000 m750 500 2500

Parks

Access to green areas 

The map show which buildings have 
access to a park larger than 1 ha 
within a 500 m walking radius. 
Most of the parks are located in 
the central and southern parts of the 
city, leaving the eastern and north-
ern areas without access to a park 
within the threshold. It is important to 
note that much of the northern area 
consists of industrial zones.

The map show which buildings have 
access to a green area larger than 
0.2 hectares within 200 metres. 
Several buildings in the city do 
not meet the threshold today. One 
disadvantage of the threshold is that 
it does not take into account how 
large the green spaces are, which is 
unfavourable for Varberg, which has 
several large green areas throughout 
the city. The map shows that the up-
take area is quite small, which could 
indicate the need for larger portions 
of small and pocket parks at neigh-
bourhood level.

Buildings with access to a green 
area > 0.2 ha within 200m

Buildings with access to park 
> 1 ha within 500 m

1000 m750 500 2500

1000 m750 500 2500

Dispersal map 

Functional map

The map show the dispersal for tree 
living bees from valuable trees in 
Varberg. The analysis shows that 
non of the core value habitats are 
connected.

The map illustrate the distribution of 
valuable trees in Varberg, which is a 
core habitat for the tree living bees. 
The analysis shows that these trees 
are unevenly distributed throughout 
the city. There is potential to create a 
core habitat network by connecting 
them through green corridors.
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Densities DistrictBlock

The area consists of town houses 
and apartments. It is on a small scale 
and can be described as a low-rise 
striped development.

The area consists of an older neigh-
bourhood with buildings arranged 
in a block structure. However, the 
façades are broken up between the 
properties and are not continuous. 
The building typology is classified as 
a hybrid low-rise stripe/block type.

The neighbourhood consists of both 
older and newer buildings, with the 
latter being taller. The new buildings 
have 5–6 floors, whereas the older 
buildings have 2–3. The building 
typology is classified as a hybrid 
low-rise stripe/block type.

The neighbourhood consists of a 
collection of single-family homes, 
ranging from one-and-a-half to two 
storeys. The buildings are classified 
as low-rise point type.

Low-rise stripe (A)

 Hybrid low-rise stripe/block type (B)

 Hybrid low-rise stripe/block type (C)

Low rise point type (D)

Fig 13: Aerial photos from Slagboom en Peeters (2024)
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Restaurants, cafés and bar

Squares

The map show the accessibility of 
restaurants, cafés and bars within 
500 metres walking distance from 
buildings. These are concentrated in 
the city centre, though some are also 
located throughout the city. A large 
proportion of the city does not have 
access to restaurants, cafés and bars 
within a 1 km walking distance.

The map show which buildings have 
access to a square within an 800 
m walking radius. As there are only 
two squares in the city, “Varbergs 
Square” in the centre and “Breared 
Square” in the south, much of the city 
has limited access to a local square.

Buildings with access to squares within 
800 m

Buildings with access to one or two restau-
rants, cafés or bars

Buildings with access to over two restaurants, 
cafés or bars
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The combined analysis suggests 
there’s a mismatch in the area’s 
spatial configuration. Both the be-
tweenness centrality is high on both 
scales and population density are 
high, which indicating an opportunity 
to create movement, the access to 
ground floors is relatively limited.
This points to an underutilization 
of available potential. The spatial 
configuration has a potential of 
creating a more mixed-use neigh-
bourhood and support more active 
ground floor uses with a wider range 
of functions, but this capacity is not 
realized by the building typology 
and the street scape.

The combined analysis indicates 
a spatial and functional mismatch 
in the area. Both local and glob-
al scales show high betweenness 
centrality, suggesting the area holds 
a potential of creating both a higher 
flow of people and co-presence. 
There’s also a relative high accessi-
bility to ground floor area. However, 
there’s a relatively low degree of 
accessible population, meaning that 
the number of people within walking 
distance is limited.

This mismatch suggests that the ar-
ea’s spatial potential is not currently 
matched by its level of everyday use. 
Increasing population density in the 
surrounding context could contrib-
ute to higher levels of co-presence 
and pedestrian flow. In turn, this 
may support more consistent use of 
ground floor spaces and improve 
the conditions for local businesses. 
While population density alone 
may not address all aspects of the 
mismatch, it represents one possible 
factor in supporting a better align-
ment between spatial configuration 
and actual use.

Mismatch 1

Mismatch 2-4

1000 m750 500 2500

Comprehensive analysis
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06. Design study
This chapter focuses on the ‘infill’ the site. First, a series of spatial 
analyses are carried out to understand the current morphological 
elements and system conditions, and to identify the potentials and risks 
of developing the site. The identified potentials are then matched with 
coherent design criteria on a system scale to spatially reconfigure the 
site. Finally, local design criteria are identified for important aspects of 
the functional form of the built environment to enhance system effects.

Based on the overall analysis, three different locations with different system 
conditions have been identified: infill, edge, and rural. Infill is geographical-
ly central in the city with high connectivity but with moderate to low access 
to building land. Edge is located on the outskirts of the urban area and has 
thoroughfares with higher connectivity but low access to building land. Rural 
is located in the countryside and has access to low connectivity and low 
building land.

Infill Edge Rural
High centrality & medium 
density

Medium centrality & low 
density

Low centrality 
& low density
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The planning area currently consists of buildings with a large floor 
area but lower building heights and a large-scale property divi-
sion. The area is divided into three building clusters.

Two main roads run through the planning area, Västkustvägen and 
Träslövsvägen, which then merge into Österängsvägen. This road 
also leads to Varberg Hospital, which is located on the border of 
the area. The grade-separated intersection between the two roads 
creates barriers in the area. Along Träslövsvägen, several proper-
ties have their driveway.

There are large parking lots adjacent to the buildings, and the 
grade-separated intersection creates two large unused areas 
between the roads and their entrances and exits. This leads to 
inefficient land use in the area, with several neglected spaces.

Although the planning area is dominated by hardened ground, 
there are also clear elements of greenery, which create conditions 
for green corridors through the area.

The residential cluster to the north west is currently occupied by 
Varbergs Energi. The central area consists of three schools, a solar-
ium, and a large grocery store. The cluster to the east consists of a 
newly built preschool and warehouse and office premises.

The planning area is largely flat, but the grade-separated inter-
section creates a low point in the area. To the south of the area, 
adjacent to Österängsvägen, the area becomes more hilly.

FunctionsTopography

Green structureParking & neglected spaces

Buildings & plots BarriersSite analysis - Infill

Area + 500m
Population	 Area	 Population/km2	 GSI	 FSI	 OSR	 L

4453		  1.07	 4200			   0.25	 0.53	 1.4	 2.1

The area is currently character-
ized by the dominance of cars in 
the streets, large industries and 
businesses, and several schools. 
Within 500 meters walking dis-
tance from the site, there are var-
ious building types on different 
scales. Two prominent building 
types are detached houses and 
lamella houses. The area is also 
characterized by larger buildings, 
mainly Varberg Hospital, but also 
Peder Skrivares School and re-
tirement homes. Since Väskust-
vägen is a grade-separated road 
and therefore does not connect to 
several local streets in the west, 
these are not within 500 m walk-
ing distance even though they 
are located right next to the area. 
Based on the space matrix anal-
ysis, the area can be interpreted 
as low-scale street development 
with low pressure on open spaces. 

Villas (A) Town houses (B)
A A A0.4 0.2 0.73 ha

FSI FSI FSI0.3 0.4 0.45

GSI GSI GSI0.2 0.35 0.19

OSR OSR OSR1.2 0.8 1.8

L L2 2.4L 1.8

Space matrix Typologies form page 41

Land use

Wind-rose
Wind speed

Fig 14: Stormhuset (n.d)

•Built up 31%
•Roads 26%
•Green 27%
•Buildings 12%
•Other 1%

•	 0.0-2.0
•	 2.0-4.0
•	 4.0-6.0
•	 6.0-8.0
•	 8.0-10.0
•	 10.0-15.0
•	 >15.0

W

N

E

S

Lamella houses (C)

A
B

C
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Potentials

Shift towards 
sustainable 
modes of travel

Pedestrian and bicycle

Biodiversity

Foster biodiversity to sup-
port ecosystem services

Diversity of uses

Diversity of functions 
and activities

Silent retreat

Recreation and nature 
experience

Public life

Meeting places, flow 
of people

Current conflicts

•	 Low FSI - inefficient land use
•	 Fragmented green spaces
•	 Hard-packed soil / Parking - Ineffec-

tive land use & heat islands
•	 Car dominated - barriers to walking 

and cycling

Potential conflicts

•	 Increased stress
•	 Removal of green infrastructure
•	 Storm water management
•	 Increased pressure on public spaces
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Combining high centrality with higher population density creates the 
potential to generate a flow of people through the site. To further promote 
urbanity in the area with active ground floors and a variety of functions, this 
should be combined with high property density along the urban corridors 
with high access to ground floors.

By planning for efficient and diverse land use, the area can accommodate 
multiple functions. To enable this, there should be a population density that 
can support these functions, as well as a high property density that can 
accommodate the various functions.

Creating places with low centrality and access to greenery, located close 
to well-integrated routes, provides opportunities for silent retreats with 
space for recreation and nature-based activities.

By connecting core areas for bees in the area with green corridors, this 
can support their spread and reproduction. This benefits pollination in the 
area and thus also the biodiversity in the area.

By generating high permeability in the street network, combined with a 
higher flow of people, which, for example, increases activity in the areas, 
thereby promoting passive safety and enabling people watching, this 
encourages increased travel on foot or by bicycle.

Public life High acces-
sibility to FSI

High acces-
sibility to GSI

High centrality on both 
local and global scale

High accessibility 
to population

High accessibility to 
different plots

Silent retreat Accessible 
green

Close to street segment 
with high centrality

Low centrality

Biodiversity Dispersal corridorsCore habitat 
values

Pedestrian and 
bicycle

Diversity in 
lands use

Public lifeHigh permeability for 
pedestrian and cyclist

Diversity of 
uses

High acces-
sibility to FSI

High accessibility 
to population

High accessibility to 
green

Diversified 
land use

High accessibility 
to different plots

Västkustvägen

Ö
sterängsvägen

Österängsvägen

Träslövsvägen

The vision outlines the development of a new 
mixed-use area that combines housing, servic-
es, and green spaces. A central aspect of the 
proposal is the re-routing of Västkustvägen to 
Österängsvägen, next to Varberg Hospital. This 
change is intended to release land for more 
diverse uses, reduce physical barriers, and en-
hance efficiency of both the land use and of the 
existing road network.

The plan proposes integrating the intersection 
between Västkustvägen and Träslövsvägen. In 
addition, the removal of the grade-separated 
section of Österängsvägen supports the creation 
of urban corridors, aligning with Varberg Mu-
nicipality’s broader urban development strategy.

The natural area surrounding Påskbergets Forest 
will be extended northwards, forming a green 
corridor between the new buildings. This will 
also contribute to a better habitat connectivity 
by linking important habitats for tree-living bees 
that can support local biodiversity.

Vision



Several alternative road alignments have been evaluated using space 
syntax analysis to ensure that the new corridors provide high between-
ness centrality at both the local and global scale. This high centrality 
together with increased building density, creates conditions for a 
mixed-use urban environment. To support a more diverse land use, 
properties should be more finely subdivided along these corridors.

A pedestrian zone will be established between the buildings from 
the park area down to Träslövsvägen, enhancing walkability and 
connectivity. The new development will feature continuous building 
frontages along the streets. However, towards natural areas and exist-
ing neighbourhoods, the built form can be broken up to better match 
the existing scale, improve sightliness, and allow more natural light into 
courtyards. An open block structure also assists ecological connectivi-
ty by enabling dispersal corridors for various species.

The natural area surrounding Påskbergets Forest will be extended 
northward, forming a linear park at the lowest elevation of the site. This 
park will include a designated floodable area to manage storm water 
runoff. The ecological corridors have been assessed using a habitat 
network connectivity tool to ensure integration with broader environ-
mental systems.FSI: 1-1.5

GSI: 0.25-0.3
OSR: 0.2-0.5
L: 3-4

FSI: 1.5-2
GSI: 0.25-0.4
OSR: 0.25-0.5
L: 3-5  

FSI: 1.5-2.5
GSI: 0.3-0.4
OSR: 0.2-0.5
L: 3-5

A

B

C
D

E

B

C

D

E

D

12.5

125

250

25

250

500

50 m

50 m

100 m

50 100 200 m

Skala 1:1000

62.5 12.5 25 m

Skala 1:500

Skala 1:1000

Skala 1:2000

Skala 1:4000

1.25

12

25

2.5

25

50

5 m

50 m

100 m

50 100 200 m

100 200 300 m

Scale 1:100 (A3)

2.5 5 10 m

Scale 1:200 (A3)

6.25 12.5 25 m

Scale 1:500 (A3)

3.125 6.25 12.5 m

Scale 1:250 (A3)

10 20 40 m

Scale 1:800 (A3)

Scale 1:1000 (A3)

18.75 37.5 75 m

Scale 1:1500 (A3)

Scale 1:2000 (A3)

Scale 1:4000 (A3)

Scale 1:6000 (A3)

Typologies in the vicinity (p. 46) Typologies in the city (p. 41)
Påskberget

Österängsvägen

FSI: 1-1.5
GSI: 0.3-0.4
OSR: 0.2-0.5
L: 3-5

FSI: 1-1.5
GSI: 0.25-0.4
OSR: 0.2-0.5
L: 3-5 

Finer plot division

Arteries

Contentious façades

Green corridor

Potential future green corridor

Potential future arteries

City center

Local center

Future local center

Important intersection

Fabric

Transformed street

Planned developments

New green area

5-7 levels

3-5 levels

2-4 levels

FSI: 2-2.5
GSI: 0.4-05
OSR: 0.2-0.5
L: 4-7

A

Träslövsvägen

Västkusvägen

B

D
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1000 m750 500 2500

Angular betweenness, 2 km New angular betweenness, 2 km
Same classes

Angular betweenness, 5 km New angular betweenness, 5 km
Same classes

Through an iterative design process in which street config-
urations were tested using space syntax analyses, a final 
proposal was produced in which the main corridors have 
high betweenness centrality on both a local and global scale. 
This increases the potential for creating co-presence in the 
area, as people moving around there can come from both the 
immediate vicinity and other parts of the city.

Design strategies 
Connect the city with urban 
corridors

By removing barriers in the 
city, such as grade separated 
intersections and roads, new 
arteries can be created to con-
nect the city and create new 
flows.

Create vibrant neighbourhoods

Instead of facing large parking 
lots, the new buildings will 
face city streets with greenery, 
continuous façades, and active 
ground floors.

Change and optimize land use

Move from large parking lots 
and traffic areas to diversified 
land use with green spaces 
and meeting places.

From car-dominated to 
pedestrian-friendly

By streamlining the existing 
road network, Västkustvägen 
can be rerouted, freeing up 
space for housing and green-
ery while removing a barri-
er to pedestrian and bicycle 
traffic.
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Intervention 1 Intervention 2 Intervention 3

Angular betweenness, 2 km
Same classes

Angular betweenness, 5 km
Same classes

By merging the West Coast Road 
with Österängsvägen, the existing 
motorized road network will be 
streamlined and space will be freed 
up in the area. However, there is a 
gap between angular betweenness 
centrality on the different scales, 
which risks overlooking the potential 
for achieving co-presence in the 
area.

In the next stage, Österängsvägen 
will be converted from a traffic-sep-
arated street to a mixed-traffic street. 
This is to strengthen the route through 
the area by making it more direct 
and thereby increasing its between-
ness centrality. Here, the two scales 
begin to interact with each other, but 
centrality is now higher on Västkus-
tvägen instead of Träslövsvägen, 
which leads to the city center.

By breaking up the street segments 
leading to Västkustvägen, Träslövsä-
gen is given clearer priority, and the 
area gains a betweenness centrality 
that is consistent on both scales. This 
creates the conditions for great-
er flow through the area and thus 
increased co-presence.

1000 m750 500 2500
The proposal gives the motorized 
road network a clearer hierarchy 
and concentrates it on existing 
roads, which reduces barriers in the 
area and allows for more efficient 
land use.

Angular betweenness, 2 km New angular betweenness, 2 km
Same classes

Angular betweenness, 5 km New angular betweenness, 5 km
Same classes
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As the catchment area for green spaces is relatively 
small, 200 meters, the plan proposal will not result in 
any major changes to their accessibility on a global 
scale. The buildings around the plan area already have 
good access to green spaces through the nature area 
around Påskberget.

Current access to green areas New access to green areas

Current access to park New access to park

The access to parks will improve for the housing to the 
north of the area, but the effects will be limited here 
too due to the restricted 500 m catchment area. One 
alternative that was considered was placing the park 
in the north-western part of the plan area, which would 
have had a marginally better impact. However, as Väst-

kustvägen remains grade-separated, new connections 
to the road would require demolition of existing build-
ings. As Västkustvägen is relatively busy, this alternative 
was considered to have too negative an impact on the 
quality of the park.

Current reproduction habitats - bees New reproduction habitats - bees

Current dispersal - bees New dispersal - bees

The surrounding core values (valuable trees) for solitary 
bees around the hospital area and Peder Skrivare’s 
school can be linked together by green corridors. This 
can increase the dispersal distance and transforms the 
site into a core value network for bees.

By extending the natural area around Påskberget north-
wards and designing the new green space to replicate 
the core habitats for solitary bees, such as insect hotels, 
the site can promote the reproductive capacity of bees 
in the area and thereby also strengthen pollination and 
biodiversity (Naturskyddsföreningen 2021).
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Design criteria - local

Public lifePedestrian and bicycle Street types

Bees Programming green areas Barriers

Private retreat Transparency Courtyards & Enclosure

Need of permeability

FunctionFacade Need of transparency

Street typesScale

Public life Facade Microclimate

Current access to squares New access to square

Current access to population New access to population

The area will be densified, and the street network’s 
connectivity enhanced, expanding the 1 km walking 
catchment area. This will improve accessibility to the 
local population, with parts of the area that share at the 
same level as the city center. These changes will sup-
port the development of diverse functions and services 
within the area.

The new square has a major positive impact on access 
to squares in the city, largely because there is currently 
a shortage of them.
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Continuous façades
Continuous façades along 
street with high betweenness 
centrality 

Plan for social meetings and differ-
ent functions

Take height for the area to 
hold multiple of functions, 
make spaces flexible so their 
use can change over time

Entrances
Have the entrances towards the 
streets and with a maximum dis-
tance between them  of 20 m towards 
activity streets to activate them 

Plots & islands
Configure the islands to match 
existing fabric and have a 
higher plot density towards 
streets with a high between-
ness centrality and access to 
high density

Connect to the existing scale 
Connect to the existing scale 
to create the desired effect

Break the façades to create a better microcli-
mate and to make space for greenery

Breaking the façades can stop wind tun-
nels and give space for greenery which 
helps mitigate the heat islands effect 
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A-A
B-B
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D-D

F-F
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Skala 1:1000
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50 m

100 m

50 100 200 m

100 200 300 m

Scale 1:100 (A3)

2.5 5 10 m

Scale 1:200 (A3)

6.25 12.5 25 m

Scale 1:500 (A3)

3.125 6.25 12.5 m

Scale 1:250 (A3)

10 20 40 m

Scale 1:800 (A3)

Scale 1:1000 (A3)

18.75 37.5 75 m

Scale 1:1500 (A3)

Scale 1:2000 (A3)

Scale 1:4000 (A3)

Scale 1:6000 (A3)

High speed road

Local street
Low speed street

Pedestrian zone

Fabric

Transformed street

Traffic & sections
The street types have been adapted 
to the centrality of the street segments 
and their potential to create flows, 
the need for movement and access 
to population density and built-up 
land.
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Important intersection

Make it possible to have active 
ground floors at important inter-
sections

Clear break on the facade to 
the ground floor

Extended curb to slow 
traffic

Raised ground floor to protect 
against insight 

Clear entrances facing the street

Street segment low betweenness centrality 
and access to low population density

Dense between entrances,15-20 m

Façades with high visual 
permeability

Street segment with high betweenness centrality and 
access to high population density
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High-speed street (A-A)

Walk Flex GreenPublic transport 
/car

Bicycle/car Walk

4m 2m 3m 3.75m 3.75m 3m 5.5m 2.5m

The street is designed on the principles for 
“high-speed road” in “smart street”and 
adjusted so that vehicles can travel at higher 
speeds (max. 40 km/h) (Ståhle et al, 2022). 
Public transport runs in the middle, while 
cyclists travel on separate lanes inside the 
flexible areas. Pedestrians move around and 
stay on pedestrian areas and in flexible are-
as. Important design principles are that side-
walks, bike paths, and flexible areas should 
have a level surface but be differentiated by 
different materials for clear guidance. For 
universal accessibility, sidewalks along the 
edges of streets must be at least 3 meters 
wide, with lowered curbs to facilitate access 
for wheelchairs and strollers. Left turns are 
minimized, especially near bus stops.

Since Västkustvägen and Träslövsvägen 
are being merged with Österängsvägen, 
this will generate a higher combined traffic 
flow, while at the same time making the road 
an important route for emergency vehicles 
from the hospital. At the same time, several 
properties currently have their exits onto 
Österängsvägen, which is not optimal in 
terms of traffic flows and ensuring high ac-
cessibility for emergency vehicles. Therefore, 
two separate lanes will be created next to 
these properties as a low-speed street that 
prioritizes the accessibility of cyclists, but 
also handles residential exits.. 
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Soft boarders

Design ground floor after their 
qualities of being close to the 
ground and the street

No visual exchange

Soft boundaries

Integrated storm wa-
ter management

Clear entrances 
facing the street

Overhanging roof 
protects against rain

Raised ground floor to protect 
against insight

Clear entrances 
facing the street
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Walk
Flex

Green/ Bicycle /car Walk

2.5m 3m 6m 3m

Low-speed streets are designed so that 
vehicles must travel at low speeds, max. 20 
km/h (Ståhle et al 2022). Pedestrians move 
and stay on separate pedestrian areas and 
in flexible areas. Low-speed streets are also 
known as bicycle streets or cycle streets. 
Important aspects of the design include even 
and permeable road surfaces, wide bicycle 
lanes, frequent crossings, and several flexi-
ble and green areas.

Low-speed street (B-B)
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Weather protected outdoor places

Interaction between the inside 
and outside of the building

Greater detail at eye level

Make it possible to have active ground 
floors at important intersections

Clear break to ground floor on 
the facade to the ground floor

Dense between entrances. 15-20 m

Extended curb allows for a flexible use

Soft boarders makes visitors feel safe

Tree’s help break wind and gives shade 
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Pedestrian zone (C-C)

Walk Flex FlexWalk

5m 6-8m 3m 2m

The design of the street is based on the street 
type “Pedestrian street” in Smarta gator 
(ståhle at al, 2020). Important aspects of 
the design include flat paving with clear 
speed bumps at the beginning and end of 
the street to indicate that pedestrians have 
priority. Street furniture, flexible spaces, 
playgrounds, and maximizing green spaces 
and permeable paving materials to manage 
storm water locally. Walking streets are 
suitable when there is a demand or need for 
people to spend time in an area and can 
therefore be suitable for residential areas, 
shopping and activity streets, and near 
schools, sports facilities, or parks 
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Park

Nature

Insect hotel

Meadow

Valuable tree

ShopCafé

Gymnasium

Student apartments

Underground parking

Square High-speed street
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Park at the lowest level to 
deal with storm water

Greenery or fences can 
create a boundary in the 
public-private interface while 
still allow for dispersal corri-
dors an sun light penetration 
to the court yard

Underground 
parking

Visual permeability towards 
the park by breaking up the 
building façades
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Sections Bee’s core habitats and dispersal (D-D)

Valuable trees
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Discussion

The purpose of this thesis has been to investigate a design methodology and 
develop a framework that can bridge the gap between strategic planning and 
detailed planning in municipal urban planning. The goal is to contribute a tool 
that supports more system-oriented and multi-scale planning processes. Two 
central research questions have guided the work:

1.	 How can a design methodology identify design criteria for how a place 
can be designed and developed based on system aspects?
2.	 How can a design methodology identify design criteria to mitigate 
socio-ecological conflicts and thereby support planning processes in medium 
sized Swedish cities?

To answer these questions, the thesis takes an EBD approach that combines 
analytical and normative theory. Analytical theory was used to understand how 
the city’s overall structures, such as the composition of different morphologi-
cal elements and spatial configurations, create different conditions for system 
effects at both the local and city-wide levels. The normative theory was then 
used to formulate guidelines for how these configurations and places can be de-
signed and combined to reinforce desired effects and reduce conflicts between 
social and ecological interests. The thesis thus also provides an evidence-based 
design process, thereby creating a more systematically grounded and mul-
ti-scale urban planning. This can also be seen as a contribution to the need to 
make research results more understandable, accessible, and practically useful 
for planners and decision-makers in urban planning (Berghauser Pont, 2024).

Although the design methodology has been the main focus of this thesis, the 
compilation of the identified design criteria can also be a positive contribution. 
Since these are based on an analytical foundation and linked to measurable var-
iables, such as the centrality, density, and land use of street networks, they can 
also be generalized and applied in other urban contexts.

The design methodology also shows how to balance multiple goals in urban de-
velopment. By integrating factors that promote human well-being, ecosystem 
services, and biodiversity, while densifying the city to reduce energy consump-
tion and preserve natural and agricultural land, it is possible to identify design 
criteria that help mitigate conflicts between social and ecological aspects.

What difficulties have emerged?
One challenge in the work has been to balance conflicting criteria during the 
design phase, such as contextual conditions, population density targets, and 
the need to work from a human scale. Balancing conflicting aspects is often one 
of the main challenges of urban planning. The method presented in this thesis 
aims to highlight these conflicts at an early stage, leading to more informed 
decisions in the planning process. 

General guidelines for density have proven difficult to apply directly, as each 
location has unique characteristics and conditions. Density guidelines there-
fore need to be flexible and adaptable to varying needs, for example with re-
gard to functions such as schools and public spaces. Tools such as Space Matrix 
have been valuable as they provide a non-normative understanding of density, 
where variables such as accessible FSI and GSI help to interpret what density 
may be desirable in relation to the specific context.

Another challenge in the work has been to identify the right level of detail, i.e., 
to determine which aspects need to be clearly regulated in the plan and which 
should be left open for flexibility. The aim has been to create a plan that is flex-
ible enough to allow for adaptation over time and in different implementation 
phases, while ensuring the functional qualities of the area, i.e., its affordance, 
as well as the desired system effects at both the local and city-wide levels.

08. Discussion
Under development
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What are the limitations of the method?
The design method is not a comprehensive answer to many of the challenges 
facing our cities today. Nor do the identified design criteria guarantee that the 
area will actually live up to the opportunities and strengths identified in the site 
analysis, as other factors, such as socioeconomic and democratic issues, have 
a significant impact on how the area develops. To believe that it is enough to 
adapt urban planning to a certain number of measures and criteria in order to 
achieve complex phenomena such as urbanity and social cohesion is to simplify 
urban planning, as it is also largely about how people use and develop places. 
However, what the design method shows is how these phenomena can be pro-
moted through the physical and economic structure of the city, both at the local 
and global level.

What would I have done differently?
One aspect that could have been improved in retrospect is how the boundaries 
of the planning area were handled. In this case, a more flexible and diffuse plan 
area boundary could have created better conditions for achieving the desired 
system effects. In order to influence functions and flows within a specific area, 
it may be necessary to also work with physical interventions outside the plan 
area. In the design study, this was illustrated, for example, by configuring the 
street network outside the plan area. By creating more connections leading 
through the area, the betweenness centrality of the routes increased, which in 
turn increased the potential for movement flows and activity within the actual 
planning area.

However, a similar system based and large scale strategy was not applied to 
the same extent when it came to the green structure, which could have yielded 
a more desirable result. The guidelines for green spaces and parks are based 
on relatively small catchment areas, which means that the effects of the plan 
proposal were limited for several parts of the city that have poor access to green 
spaces. By working on a larger scale, it would have been possible to create a 
more comprehensive and significant impact.

How can the method be further developed?
For further research and to further develop the design method, it would be 
both interesting and relevant to include economic aspects to a greater extent. 
Co-presence, ecosystem services, and flows of people have an exchange value 
(their economic impact on food production or property values). By identifying 
and including these, the method could also support economic implementation 
issues in the plan and strengthen the argument for why these aspects must be 
given a greater place in how we plan our cities.
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ChatGTP (OpenAI 2025) was used as a tool in the 
spatial analyses by generating explanations of how 
geodata should be processed to enable the analyses. 
AI was also used as a testing ground in an initial phase 
to discuss methodology and process issues and, to 
some extent, to find relevant sources on specific issues.

Promt: How can I calculate building heights based 
on digital surface models (DSM) and digital elevation 
models (DEM) using Qgis?

Asnwer: To calculate building heights using Digital 
Surface Models (DSM) and Digital Elevation Models 
(DEM) in QGIS, you simply subtract the ground eleva-
tion (DEM) from the surface elevation (DSM). Here’s a 
step-by-step guide:

• DSM: Includes elevations of buildings, trees, 
etc.
• DEM: Includes only ground elevation (bare 
earth).
• Both layers must:
o Be in the same CRS (Coordinate Reference 
System).
o Have the same resolution and alignment (you 
can resample if needed).
1. Load the DSM and DEM
• Use Layer > Add Layer > Add Raster Layer to 
load both DSM and DEM into your project.
2. Align DSM and DEM (if needed)
If they’re not the same resolution or extent:
• Use: Raster > Align Rasters (plugin may be 
required).
• Set the same pixel size, extent, and alignment.
3. Subtract DEM from DSM
Use the Raster Calculator:
• Go to Raster > Raster Calculator
• Use this expression:
“DSM@1” - “DEM@1”
Replace “DSM@1” and “DEM@1” with the actual 
layer names as shown in the calculator.
• Name the output (e.g., Building_Height.tif)
• Set output CRS and location
• Click OK
This produces a new raster where each pixel value 
represents the building height (or vegetation height, if 
present).
________________________________________
If you have a building footprint layer:
1. Use Raster > Extraction > Clip Raster by Mask 
Layer with your building polygons.

2. Alternatively, use Zonal Statistics:
o Raster > Zonal Statistics
o Input: the height raster
o Polygon layer: your building footprints
o Output: mean, max, or min height per building.

Promt: How can land use be calculated as a percent-
age in QGIS based on land cover data?

Answer: To calculate land use as a percentage in 
QGIS based on land cover data, follow these general 
steps. This process typically uses raster or vector land 
cover datasets where each class corresponds to a 
specific land use/land cover type (e.g., forest, urban, 
agriculture).
1. Load your land cover raster
• Add the raster dataset to QGIS. Each pixel 
should represent a land cover class (usually with inte-
ger values).
2. Reclassify if needed (optional)
• If the land cover classes need grouping (e.g., 
multiple codes for different forest types), reclassify 
using:
o Raster > Raster Calculator or
o Processing Toolbox > Reclassify by table
3. Calculate area per land cover class
• Go to Processing Toolbox → search for “Raster 
Layer Unique Values Report”.
• This generates a table with each land cover 
class and the number of pixels.
4. Convert pixel count to area
• Multiply the number of pixels by the pixel size 
(resolution).
o Example: If resolution is 30m x 30m, each 
pixel = 900 m² = 0.09 ha.
o Use Field Calculator to add a new field:
plaintext
KopieraRedigera
area_ha = pixel_count * (pixel_size_x * pixel_size_y) 
/ 10,000
5. Calculate total area
• Sum all areas (can use the Statistics Panel or 
export the table to Excel).
6. Calculate percentage per class
• In the attribute table, use Field Calculator:
percentage = (“area_ha” / total_area_ha) * 100

Promt: How do i use las tools in Qgis do idetify whats 
buildings in lidar data?

Answer: To use LAStools in QGIS to identify buildings 

AI-appendix
in LiDAR data, follow these steps. LAStools is a pow-
erful set of tools for processing LiDAR data (.las/.laz), 
and QGIS can integrate them via the LAStools plugin.
________________________________________
Step-by-Step: Identify Buildings from LiDAR in QGIS 
using LAStools
________________________________________ 
1. Install LAStools and the QGIS Plugin
A. Download LAStools
• Get it from: https://rapidlasso.com/lastools/
• Extract it to a folder, e.g., C:\LAStools.
B. Install the LAStools Plugin in QGIS
• Open QGIS
• Go to Plugins > Manage and Install Plugins
• Search for LAStools, and install it
LAStools is free for academic/non-commercial use; a 
license is needed for full commercial functionality.
________________________________________
2. Load Your LiDAR Data
• Go to Layer > Add Layer > Add Vector Layer
o Or use Add LAZ/LAZ file via LAStools toolbar.
• Select your .las or .laz file (LAS = LiDAR data 
format)
________________________________________
3. Classify the Point Cloud to Identify Buildings
Use the lasclassify tool:
How:
• Open the Processing Toolbox (Panel)
• Search for lasclassify and open it
• Set parameters:
o Input LAS/LAZ files – your LiDAR file
o Point Source ID – optional
o Extra Options – you can add:
-fine or -ground for better results depending on the 
data
o Output Directory – choose where to save 
output
• Run it
This classifies points into ground (2), vegetation (3–5), 
buildings (6), etc.
________________________________________ 
4. Filter Points to Show Buildings Only
Use las2las to extract only buildings:
How:
• Search for las2las in the Processing Toolbox
• Set parameters:
o Input – classified .las/.laz file from previous 
step
o Filter – keep_class 6 (building class)
o Output – path to save filtered file
• Run it

You now have a building-only point cloud.
________________________________________
→ 5. Visualize or Convert to Vector (Optional)
If you want building footprints (polygon shapes):
Option A: Convert to Raster (DEM of buildings)
• Use lasgrid or las2dem to make a raster sur-
face from the buildings
o Set step (grid resolution), e.g., 1.0 meter
o Use -keep_class 6 to include only buildings
Option B: Vectorize the Raster
• Use Raster > Conversion > Polygonize (Raster 
to Vector) in QGIS
• Clean and simplify polygons if needed
________________________________________
→ Summary of Tools Used:
Purpose Tool
Classify point cloud lasclassify
Filter buildings only las2las
Create building raster lasgrid or las2dem
Convert raster to vector QGIS Polygonize

Promt: Please provide me with tips and relevant 
sources for a thesis in architecture and urban planning 
that aims to identify design criteria for places through a 
systems approach where places are examined based 
on their relative locations in the larger urban system.

Answer: That’s a rich and forward-thinking thesis top-
ic—using a systems approach to identify design criteria 
based on a place’s relative location in the larger urban 
system can bridge architectural design with urban 
morphology, complexity science, and spatial analysis. 
Here’s a comprehensive guide with tips, themes, and 
sources to help you structure your research effectively:
Key Themes and Framing Tips
1. Define the Systems Approach in Urban Contexts
• Acknowledge cities as complex adaptive 
systems.
• Examine multi-scalar relationships: how local 
places relate to and are shaped by city-wide systems 
(transport, land use, economy, ecology).
________________________________________
2. Classify Places by Network Position (Not Just Typol-
ogy)
• Traditional design looks at use or typology 
(e.g., park, plaza).
• Your focus is positionality — how central, 
peripheral, connected, or isolated a place is within the 
urban fabric.
Analytical tools:
• Space Syntax (for spatial configuration and 
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visibility)
• Centrality Metrics from Network Analysis (be-
tweenness, closeness, eigenvector)
• Urban Morphology tools (e.g., plot-based 
morphometrics)
________________________________________
3. Develop Criteria Based on System Roles
Each place type (by position) might need different 
design responses:
• A central node might prioritize high capacity, 
visibility, and mixed-use.
• A peripheral connector might need to facilitate 
transitions or buffer zones.
• A network bridge could emphasize integration 
and continuity.
Use the system’s function to inform rather than impose 
design logic.
________________________________________
 Key Literature & Sources
 Theoretical Foundations
• Batty, M. (2005). Cities and Complexity. 
[Great intro to complexity and systems in urbanism]
• Alexander, C. (1965). A City is Not a Tree. 
[Critique of rigid hierarchies; supports systems thinking]
• Hillier, B., & Hanson, J. (1984). The Social Log-
ic of Space. [Space Syntax theory and tools]
• Lynch, K. (1960). The Image of the City. [Foun-
dational for cognitive mapping of places in systems]
• Jacobs, J. (1961). The Death and Life of Great 
American Cities. [Early systems thinker in disguise—im-
portance of diversity, flow, and emergent order]
 Methodological Tools
• Space Syntax: UCL’s Bartlett Lab (spacesyn-
tax.com)
• Urban Network Analysis Toolbox (MIT, in 
Rhino/Grasshopper or ArcGIS)
o Sevtsuk, A., Mekonnen, M. (2012). Urban 
network analysis. Environment and Planning B.
• Morphological Approaches:
o Kropf, K. (2018). The Handbook of Urban 
Morphology.
o Oliveira, V. (2016). Urban Morphology: An 
Introduction to the Study of the Physical Form of Cities.
________________________________________
Case Studies & Applications
• Transit-Oriented Developments and how 
node-place relationships (Bertolini, 1999) guide de-
sign.
• The Node-Place Model:
o Bertolini, L. (1999). Spatial development 
patterns and public transport: the application of an 

analytical model in the Netherlands. Planning Practice 
and Research.
Recommended Structure for Thesis
1. Introduction
• Problem definition: current place-based design 
lacks systemic awareness.
• Objective: identify design criteria based on 
systemic roles.
2. Literature Review
• Systems theory, complexity, space syntax, 
urban morphology.
• Place theory and design evaluation.
3. Methodology
• Select city/area.
• Apply network-based positional analysis 
(Space Syntax, UNA).
• Categorize place types by systemic role.
4. Case Studies
• Select diverse urban locations within different 
positions in the system.
• Analyze spatial metrics + field observation.
5. Derive Design Criteria
• Translate systemic insights into practical design 
recommendations.
• Possibly create a design decision matrix based 
on place function in the system.
6. Conclusions and Implications
• For practice, planning, and future design re-
search.
________________________________________
Tools You Might Use
• Rhino + Grasshopper (for visual scripting + 
Urban Network Analysis plugin)
• DepthmapX (Space Syntax analysis)
• GIS (ArcGIS or QGIS for mapping networks)
• R or Python (for complex spatial network anal-
ysis)
Additional Reading/Resources
• Journal of Urban Design
• Environment and Planning B: Urban Analytics 
and City Science
• ISOCARP, AESOP, and CITIES journal

Promt: What is important to consider when developing 
an evidence-based design methodology in a thesis in 
architecture?

Answer: When developing an evidence-based design 
(EBD) methodology in an architecture thesis, it’s critical 
to approach the process with academic rigor, clear 
structure, and relevance to both design and research. 

Below are the key considerations:
________________________________________
1. Clarify the Research Question
• Define a specific, focused question or hypoth-
esis that guides the design exploration.
• Ensure it’s a question that benefits from em-
pirical data and measurable outcomes, e.g., “How 
does classroom layout affect student concentration in 
primary schools?”
________________________________________
2. Understand What “Evidence” Means in Your Con-
text
• Evidence can be quantitative (e.g., daylight 
levels, acoustic performance, user surveys) or qualita-
tive (e.g., interviews, post-occupancy evaluations, case 
studies).
• Choose evidence types relevant to your de-
sign goals and research objectives.
________________________________________
3. Develop a Theoretical Framework
• Ground your methodology in existing theories 
or models (e.g., environmental psychology, hu-
man-centered design, sustainability frameworks).
• This creates a bridge between research and 
design, and justifies your choice of evidence.
________________________________________
4. Use a Mixed-Methods Approach (if appropriate)
• Combine quantitative data (e.g., spatial met-
rics, usage statistics) and qualitative insights (e.g., user 
feedback, observational studies).
• Mixed-methods increase validity and provide 
a more holistic understanding.
________________________________________
5. Identify and Analyze Precedents
• Use case studies of built projects that used 
EBD, analyzing what data was collected, how it in-
formed the design, and what results were achieved.
• Critically assess their relevance and applica-
bility to your own design problem.
________________________________________
6. Design Testing and Simulation
• Use tools such as simulation software (e.g., 
daylight analysis, energy modeling, CFD) to test de-
sign hypotheses.
• These tools generate evidence during the 
design process, allowing iterative development.
________________________________________
7. User Involvement and Feedback
• Involve stakeholders or users through inter-
views, surveys, participatory workshops, or focus 
groups.

• Incorporate their needs, behaviors, and prefer-
ences into your design rationale.
________________________________________
8. Evaluate Outcomes with Metrics
• Define measurable criteria for success: com-
fort, usability, performance, satisfaction, etc.
• These should align with the original hypothesis 
and be testable through your design.
________________________________________
9. Document the Process
• Transparently show how evidence informed 
key design decisions at each stage.
• Include both the successes and limitations of 
using EBD in your thesis.
________________________________________
10. Ethical and Practical Considerations
• Ensure ethical data collection, particularly with 
human subjects (e.g., informed consent).
• Consider the feasibility and scalability of your 
methods.
________________________________________
Bonus: Example Methodology Structure
1. Introduction & Problem Statement
2. Literature Review (Theories, Precedents, Evi-
dence Standards)
3. Methodology (Data Collection + Evaluation 
Framework)
4. Design Exploration (Informed Iteration + Evi-
dence Application)
5. Results (Evaluation of Design Outcomes)
6. Conclusion (Findings, Limitations, Future Work)

Promt: Can you give me two sources that explain what 
population density urban sprawl causes?

Answer: Urban sprawl typically results in lower 
population densities as cities expand outward into 
suburban and rural areas. This expansion often leads 
to dispersed development patterns, characterized 
by single-use zoning and a reliance on automobiles. 
Such patterns can have significant implications for 
infrastructure, environmental sustainability, and commu-
nity cohesion. 
Here are two sources that delve into the relationship 
between urban sprawl and population density:
________________________________________
1. OECD – “Rethinking Urban Sprawl: Moving 
Towards Sustainable Cities”
________________________________________
2. ScienceDirect – “Measuring Sprawl with Den-
sity-Allocation Indicators”
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________________________________________
These sources offer comprehensive analyses of how 
urban sprawl influences population density and the 
broader implications for urban planning and sustaina-
bility.

Promt: Can you give me two sources that explain 
how building typology affects wind and microclimate?

Answer: Certainly! Here are two scholarly sources 
that delve into how building typology influences wind 
patterns and microclimate in urban environments:
________________________________________
1. Designing the Urban Microclimate: A Framework for 
Integrating Climate Knowledge into Urban Design
tical design guidance.
________________________________________
2. The Contribution of Urban Morphology to the For-
mation of the Microclimate in Compact Urban Cores: 
A Study in the City Center of Thessaloniki
________________________________________
These studies provide valuable insights into how build-
ing typology and urban design influence wind patterns 
and microclimate, informing strategies for creating 
more comfortable and sustainable urban environments.
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